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Preface

Welcome to the Oracle Insurance Insbridge Rating and Underwriting RateManager Administrator User
Guide. This guide describes the features and functionality of the Oracle Insurance Insbridge Rating and
Underwriting RateManager (RateManager) Tools Menu. RateManager is a component within the Oracle
Insurance Insbridge Rating and Underwriting (IBRU) System that enables users to manage the product
definition and modification process, including rating and underwriting logic. The Tools Menu is where the
majority of RateManager Administrator functions are performed. References to the RateManager User
Guide, which covers the Modules Menu, will be made periodically.

AUDIENCE

This guide is intended for RateManager system administrators who are tasked with managing system
features. Users should be familiar with their company’s practices and terminology. Advanced users may
benefit from having knowledge of their company’s current working rate manual.

RELATED DOCUMENTS

For more information, refer to the following Oracle resources:
e The Oracle Insurance Insbridge Rating and Underwriting Framework Administrator User Guide.
o The Oracle Insurance Insbridge Rating and Underwriting SoftRater Server User Guide.
¢ You can view these and other IBRU guides on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

CONVENTIONS

The following text conventions are used in this document:

Convention  Description

Boldface type indicates graphical user interface elements associated with an

bold :
action.

ltalic Italic type indicates book titles, emphasis, or placeholder variables for which you
supply particular values.

N —— Monospace type indicates commands within a paragraph, URLs, code in

examples, text that appears on the screen, or text that you enter.

Vii


http://www.oracle.com/technetwork/documentation/insurance-097481.html�

Preface

SYSTEM REQUIREMENTS

For minimum operating system and hardware requirements, please see the Hardware Software
requirements guide.

Manual History

New editions incorporate any updates issued since the previous edition.

Edition Zﬂﬂ'g’:r“on \P/;?gilé%t Publication Date Comment

1% Edition P01-775-01 R 4.0 May 2010 New Release Update
2" Editon  P01-775-02 R 4.0.1 August 2010 Updated Release

3" Edition P01-775-03 R 4.1 December 2010 Update Release

4" Editon  P01-775-04 R 4.5 May 2011 Update Release
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Chapter 1
SYSTEM OVERVIEW

Prior to accessing RateManager, you should have received:

o RateManager URL — RateManager can be accessed by going to http://<yourserver>/rm, where
<yourserver> is the name of the server where RateManager is installed.

e Username — usernames are required.

e Password — passwords are required.

e Subscriber — subscriber information may not be required.

A subscriber may be a single company, a group within the company, or a single person. If more than one
subscriber has been set up by the system administrator, you will have to select the subscriber where you
want to work. If only a one subscriber has been setup, you will not have to select a subscriber.

If you do not know any of this information, please contact your system administrator.

Vi Sen Wiz Vet
If multiple subscribers have been setup, there will A single subscriber will only have username and
be a menu for users to select the subscriber they password fields. Subscriber information will not be
will work under. required.

Logging In

Access to RateManager is gained through a login screen. To login, enter your username and password
and click LOGIN. Depending on your company setup, you may need to select your subscriber. If a
company subscriber is required, a menu will be displayed. Select the subscriber you need, and continue

to log in.

A successful login will place you on your Home Tab.

A failed login will display an error message. Please correct any errors and try again. If you cannot log in,
please contact your system administrator.




Chapter 1 — System Overview

Help Logging In

If you have forgotten your password, username or need assistance with logging into the system, please
contact your system administrator.

Rights

RateManger uses rights to allow users access to various areas. The type of rights you have will determine
what you can view, edit, add or delete. There are three types of rights:

e No Access —you cannot enter this area. The fields will be grayed out or not displayed.

o Read Only — you can view the information but you cannot make any changes. Save, edit or other
features may be listed on the toolbars or right click menus, but you will not be able to effect any
changes.

e Full Access — you can view, edit, add or delete information where applicable.

The system administrator sets group rights. If there is an area you cannot enter or edit, and you think you
need access, please contact your System Administrator.

Logging Out

Logging out will remove you from RateManager.

OIRACLE" Insurance Insbridge RateManager

File Modules  Tools Help
Reload

%; Lagout

Figure 1 Logging Out

To log out, click File>Logout. If you have any elements open that show a change, you will be asked if
you want to save. After saving your work, you will be logged out.

Internet Explorer

RateManager requires an ActiveX controller. Most of the time you will be prompted to install this controller
when you begin to use RateManager. A message bar will be displayed at the top of the screen. You can
run the ActiveX controller from there. If you experience issues with some RateManager screens in
Internet Explorer 7 or Internet Explorer 8, the ActiveX Control may need to be re-registered. Please
contact your system administrator for the RateManager for the RateManager_IE7_IE8.exe included in
the installation download.

NOTE: The IBRU system currently requires Microsoft Internet Explorer release 7.0 or 8.0.

10



Chapter 1 — System Overview

RATEMANAGER TABS AND MENUS

RateManager allows for multiple tabs to be utlized. The tabbed authoring interface allows for multiple
activities to be open across separate tabs without losing any functionality. Each tab functions
independently. You can view the Program Explorer, then edit a program version, and then create a new
algorithm without being forced to close the prior tab.

The RateManager tabs follows a familiar model, a fixed top bar menu with four options. Each option
contains a menu of system features. Each feature will open either a new tab or a popup window. The new
menus contain the same features that were in previous releases of RateManager.

ORACLE" Insurance Insbridge RateManager

File Modules Tools Help
Feload

%m Logout

The File menu:

Reload — reloads the page. Use this option when you want to refresh the screen.

Logout — logs you out of the system.

ORACLE" Insurance Insbridge RateManager

File Modules Tools Help
anj Program Explarer

@ Testing

i:] Impact Analysis
B Releases
WorkFlows

Bl Llibrary

The Module menu:

Program Explorer — the program explorer holds sublines, folder, programs and program
versions. Many of the procedures and functions performed under the line of business are found
here.

Testing — opens the testing module. This area allows you to test your rating program during
development without loading packages. In previous releases, this area was called
ScenarioManager.

Impact Analysis — opens the area for batching and data analysis. This area is a combination of
previous release BatchManager and PricingManager modules.

11



Chapter 1 — System Overview

Releases — allows groups of rating packages to be automatically deployed and loaded to IBFA
through a release. If you do not have release rights, this option will not be displayed. Please see
the RateManager Tools User Guide for more information.

Workflows — A collection of programs from all lines of business combined with output mappings
and assigned to execute in sequence that returns a single or multiple results. In previous
releases, this area was called Universals.

Library — the library is where templates are stored and managed.

OIRACLE" Insurance Insbridge RateManager

File

Home

Modules  Tools Help

&'i Manage Lines

O Audit

|.|_'E‘| Irnport Programs
3 Migrate Work Files

1d

@ Security 3
B Database b
Change Password

751 Preferences

The Tools menu:

Manage Lines — opens a screen where administrators can manage lines of business. This is an
advanced system feature and may not be available to all users.

Audit — contains the audit logs of system users. In previous releases, this area was called Logs.
This is an advanced system feature and may not be available to all users.

Import Programs — is where programs are imported. This is an advanced system feature and
may not be available to all users.

Migrate Work Files — this option migrates the work files from previous releases into the current
release. This is an advanced system feature and may not be available to all users.

Security — is where users, user groups and sessions are managed. This is an advanced system
feature and may not be available to all users.

Database — this area is for administrators to create backups and deploy updates. This is an
advanced system feature and may not be available to all users.

Preferences — brings up the window where you can select the snaps you want to display on your
Home Tab. For advanced system users, system setup information will be displayed.

Change Password — allows users to change their password.

12



Chapter 1 — System Overview

OIRACLE’ Insurance Insbridge RateManager

File Modules  Tools Help

Home ) RateManager Help

RateManager Yersion

The Help menu:

RateManager Help — clicking this option will bring up online help.

RateManager Version — clicking this option will bring up system information. In previous
releases, this area was called Versions.

Tab Navigation

Multiple tabs can be open at any ti‘me. You can move from tab to tab by clicking the tab you want. You

also can click the tab display icon = in the upper right hand of the screen to see a list of all the open
tabs. You can navigate to any tab in the list by selecting it.

ORACLE Insurance Insbridge RateManager Version: 04.05.00 Subscriber: alamere User: Company Administrator
Fie Modues Tools  Help
Home Program Explorer [ Bentonville :: Auto >... B CO-Insured [1] :: Au... New Algorithm x ==
Auto > Bentonville > Version 1 > New Algorithm > Revision 1 one
H save New Step ~ | @ Delete Term | (kg Delete Step | el Change Step Order [ Advanced Options Program Explorer
[ Bentonvils :: Auto > Bentonwils > Yersion 1 —
JT— Revmon: 1 Advacsd ptons 07
[E] coO-Insured[1] :: Auto = Bentonwille = Wersion 1
Warking Category (Loap On): | Policy v | Browse Q
Mew Algarithm s
1

Steps Algorithm Details Available Variables, Functions, and Constants

NOTE: If you have a popup window open, you will have to close the popup before you can click on
another tab.

[#] - The close tab icon will close the tab you are currently on. If you have any elements open that show a
change, you will be asked if you want to save.

Home Tab

Once you have logged in, you will be on your Home Tab. The Home tab has a control panel that contains
links to all the major components of RateManager. Additional panels called Snaps also can be added.
Snaps are modules that contain information or links to elements that you recently worked on. For
example, if you selected the snap My Recently Opened Programs, you would see a list of the last 10
programs that you opened.

The Home tab can be customized to contain the information you want to see immediately when you log
in. The Home tab will always be the first tab and cannot be closed.

13



Chapter 1 — System Overview

The Control Panel contains links to all the major components found in the Modules menu. This area
cannot be removed but can be reduced by clicking the arrow in the upper right hand corner of the panel.
The Tools menu does not have a link in the Control Panel.

The RateManager home page displays the current username, subscriber and version at the top of the
screen.

Access to the pages you are authorized to view or change is gained by selecting the area you want from
the menu bar or clicking the icon on the Control Panel. Under the Program Explorer, each line of business
where you have access is displayed. If you have been granted edit privileges, you can add or change
information.

For more on the Home Tab, please see RateManager Modules User Guide.

14



Chapter 2
MANAGE LINES

The Manage Lines of Business (LOB) screen gives you a snapshot of all the lines of business currently in
the system and shows if the line is activated or deactivated. RateManager comes with 29 system lines.

Lines of business should be setup prior to creating non-admin users. If you create regular users without
any lines being activated in the system, you will have to return to the Group Management screen to
assign permissions.

NOTE: The Manage LOB screen is available to system administrators only. If you do not have this role,
you will not be able to perform these actions.

Navigating to the Line of Business Screen

1. From the menu tree, expand Tools and select Manage Lines.

ORACLE" Insurance Insbridge RateManager
File Modules Tools Help

&'i Manage Lines
S audit

% Imnpork Programs

Home

5 Migrate Work Files
IE_ Security k
A Database 3
Change Password
371

Preferences

2. This will display the Manage LOB screen.

15



Chapter 2 — Manage Lines

ehpage Dialog g

& Manage LOB
New | [ Edit
Showr listing for ﬁn5:| Al A
D Diescription Activated Typa
1 Auto SYS ~
2 Home =) §=
3 Life 5¥5
4 BOR 5YS
] Fire 5¥5
6 Umbrella 5YS
7 Waluables 5Y5
8 Watercraft 5YS
El Farmownears =) §=
i0 Disability 5¥5
i1 Commercial Auto 5YS5
iz Automated Underwritting 5YS
13 Directors And Officers SYS
14 General Liability SYS
15 Commercial Property SYS —
16 Non Subscription SYS
17 Boiler And Machinery SYS
ig Packzage SYS
is Medical 5YS
20 Workers Comp SYS

1 Artizan SYS bt

Selected Menu Ttem:  Line Of Business Listing Humber of Lines: 23

@ Close |

Figure 2 Manage LOB Screen

Manage LOB Menu Bar

The menu bar at the top of the screen allows you to:

New  New starts the process of creating a new line of business. See Creating New Lines of
Business for more information.

2 Edt  Egits the currently selected line of business.

Show listing for lines: Allows you to view LOBs by activation status. Select the status you want
to view from the drop down menu.

- ALL - Selecting ALL will display all of the lines currently in the system.
- Activated — Selecting activated will display only the currently activated lines.
- Deactivated — Selecting deactivated will display only the deactivated lines

All'is the default selection. If you choose another selection, the screen will refresh with your
choice.

16




Chapter 2 — Manage Lines

Manage LOB Fields

Lines are listed by ID number. The total number of lines in the system, both activated and deactivated, is
displayed on the bottom of the screen.

ID: The unique identifier assigned to each line of business. Once assigned, these numbers
cannot be changed.

Description: The name of the line of business. Names must be unique. Duplicates are not
allowed.

Activated: A check in this column indicates that the line of business has been activated and is
ready for use.

Type: Shows whether the line is:

e System built. System built lines of business are the standard lines that were included in
the original download of the system. System lines cannot be deleted.

e Custom built. Custom built lines of business are lines that were added later. Custom line
can be deleted.

Manage LOB Functionality

The Manage Line of Business screen allows you to do the following:

Create a New Line of Business

Edit a Line of Business

Activate a Line of Business

Deactivate a Line of Business

Remove All Programs from a Line of Business
Delete Custom Lines of Business

NOTE: System lines of business cannot be deleted. If there is a System line of business you no longer
need, you can deactivate it. This will stop the line from being listed and being available. Custom
lines can be deleted.

LOCALE

Prior to creating a new line or activating a line, you should have the locale you want to use in mind.
Locale is defined as the unique attributes of a location including formatting of dates and numbers. A
default locale including a date and number format will be obtained from the server where the IBRU
system was installed. The default locale from the server will be the default locale for every LOB.

The server locale is used as the default locale for the LOB. The locale for the LOB is used as the default
locale for the program.

The LOB locale will be the default locale used by any programs in that line. The program level locale can
be updated to a different locale.

17



Chapter 2 — Manage Lines

Selecting a Locale

There are two places where you can select the locale:

o LOBlevel
e Program level — For more on Program Locale, please see the RateManager Modules guide.

Select a Locale at the LOB Level

The New Line of Business screen and the Edit Line of Business screen will contain a drop down of
available locales. The default will be the locale of the sever where the IBRU system is installed. A Locale
must be selected. You can select a different locale when you activate a system LOB, edit an LOB or
create a new LOB.

After selecting the Locale, the Date Mask, the Decimal Symbol and Digit Grouping Symbol will be
automatically filled with the defaults from the server where the IBRU system is installed. These values can
be updated and you will be allowed to type in an alternate value if you choose. You must have a value in
the Date Mask, Decimal Symbol and Digit Grouping Symbol fields. The values set at the LOB level will
apply to as the default locale to every program created in the line regardless of subline.

To verify a locale, Edit the Line of Business. The Edit screen will list the selected locale of the LOB.
Updating a Locale

Updates to Locale at the LOB level will affect new programs. Existing programs will not be affected by
updates. Existing programs will already have a locale set at the program level.

WARNING: Changing date and number formats may result in programs not running properly. Global
elements that have been created as one type of date and number format may not function
as expected with another date and number format. Date and number formats should be
consistent through the program.

Date

Date formats are displayed as entered and will be executed and evaluated as you expect during rating.
Date formats will be carried through to any new versions or revisions.

Dates must contain:

2 digit Month entry MM

2 digit Day entry DD

4 digit Year entry YYYY or a 2 digit Year entry YY

One of 3 separators minus sign ( - ), period ( . ) or slash (/) Special characters will not be
allowed. The list of special characters can be found the RateManager Modules User Guide.

Date formats are defined in the LOB. Any program in the line will use the defined format. A different
format can be entered in the program.

o Date formats can be in any combination of the mandatory fields, for example MM/DD/YYYY.
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Date format is case sensitive. You must you capital M, D and Y.

A separator must be used, i.e. slash(/) MM/DD/YYYY, minus sign ( - ) DD-MM-YYYY, or period (

.) MM.DD.YYYY.

Number Formatting

Number formatting refers to the decimal and digit separators found in common number formats, for
example, 1,000.00 or 10.000,00.

Decimal Symbol — The decimal symbol indicates the integral part of a number from the fractional
part. For example, 10.25 (using a period as the decimal symbol) or 8,50 (using a comma as the
decimal symbol).

Digit Grouping Symbol — The digit grouping symbol indicates the symbol that will be used to
show the thousands separator. For example, 1,000 (using a comma as the digit grouping symbol)
or 1.000 (using a period as the digit grouping symbol).

The digit grouping symbol is used for validation purposes and not for display purposes.

Number formats are defined in the LOB. Any program in the line will use the defined format. A different
format can be entered in the program.

Most separators, i.e. comma (, ), period ( . ), or space ( ) will be allowed. The special characters
apostrophe ( ‘), pound ( # ), ampersand ( & ), quote ( “), less than (<), and greater than (>) will
not be allowed. A complete list of special characters can be found the RateManager Modules
User Guide.

You cannot use the same separator for the decimal and digital. The separators must be different.
Only one separator per entry. You will not be able to enter a space ( ) for the millions separator

and then a comma ( , ) for the thousands separator. You will have to select either the space or
the comma.
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Creating a New Line of Business

Custom lines may be added at any time by a RateManager administrator. LOB ID numbers are entered
manually. This allows you to match any LOB that may be Custom from the Library. LOB ID numbers must
fall between 100-250.

To Create a New Line of Business

1. Navigate to the Line of Business screen.

2. Click New. A New Line of Business popup will be displayed.

& New Line of Business -- Webpage Dialog

" i |
Name: | |
Locala: English (Unnted States) ot
Date Mask: MM/DDMNYY b
Decimal Symbol: . -
Digit Grouping Symbol: | -
Line Activated: [F]
e  Save 3 Close

Figure 3 Entering a New Line of Business

3. Inthe new line of business popup, enter an ID number. The number must be an unused number
between 100 — 250. If the number is out of range or being used, you will receive an error
message. This number cannot be changed after you save.

4. Enter a name. The name may consist of up to 50 characters.

5. Select the locale.

6. If needed, enter a date mask. This date format will be used as the default for all programs
created within that line of business.

7. Select the Decimal Symbol. This is the default decimal symbol that will be used for all programs
created within that line of business.

8. Select the Digit Grouping Symbol. This is the default digit grouping that will be used for all
programs created within that line of business.
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9. By clicking the Activated checkbox, the line of business will be activated after saving.

10. Click Save. The line of business, if activated, should show in the Program Explorer->Program
Folders navigation bar. If it does not appear, click the “Sync Menu” button in the upper portion of
the navigation bar. This is for Admin Users only. All groups except Administrators will be denied
access to any new line of business. You must allow the group access before any program options
will be available to them.

11. Navigate to Tools—> Security=> Group Management to set permissions. This will allow groups
access to view or edit variables, algorithms and other program options.

NOTE: Adding a line to group permissions needs to be done for a first time activation only. If you
deactivate and then activate again, you will not need to reset permissions.

ORACLE’ Insurance Insbridge RateManager

Fle Modues Toos Help

[ Fome 7‘ & Group Managemer X = (¥

”Group
: [ vew | [ edit | 3€ ndbte | 7 Rights | §) Rffresh |

Group Location Users

ADMIN ADMIN 1
Rateloading This group vill load rates. Plano 2
QA QA for the team Dallas 2
RateAnalysis. Rating analysis Frisco 2
BA Business analysis for rating

AaronGroup Aardn group for rating
Group Rights
3 RateManager Warkflow - Access Granted el
=8 [ Programs
=[] Scenario
-8 [#] Warkilow Mapping
=[] Inputs
+-8 [#] Warkilows
3 RateManager Package Admin - Access Granted
&[] Program Export
&[] Program Import
&[] Release Management
3 Database Support- Access Denied
=& RateManager Auto - Access Granted
= [7] Variables
& [ wirite Access
=[] Algorithms
- [#] Driver Assignment -

o Save &) Cclose

Selected Menu Ttem:  Group Management

Figure 4 Setting Security for New Lines of Businesses

12. Select the group that will need access to the new line of business.
13. Click on Rights. A Group Rights screen will be displayed. Expand out the new line of business.
14. Place a check in all the boxes where the group will require access. Click Save. Users in that group

will now be able to view and use the selected options. For more on user groups and rights, see Group
Management.
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Editing a Line of Business

Any line of business may be edited at any time.

1. Navigate to the Line of Business that you want to edit.

&» Manage LOB
[ mew | 22 Edit

Show listing for ﬁl‘lE:| all w

1D Description Activated Type

1 Auto Edit s
2 Home Activate S
3 Life 5

Figure 5 Selecting a LOB to Edit

2. You can double-click the line of business you want to edit or select it and click Edit. You also can
right click and select Edit from the menu. The Edit LOB popup will open, allowing you to edit the
line of business.

A Edit Line of Business Info - Webpage Dialog

T —— |Aut:: |
P |Eng|i5h (United States) M |
Date Mask: Yy Y-MM-DD x
Decimal Symbol: . =

Digit Grouping Symbol: | =~ ¥

Line Activated:

w® Save | € Close |

Figure 6 Editing an LOB

3. Make any necessary changes. Every field can be edited.

4. When you are finished, click Save. The line of business will refresh with the changes you made.
Click Close to go back to the Manage LOB screen without saving any changes.
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Activating and Deactivating a Line of Business

Any line of business may be activated or deactivated at any time. Activating a line of business will display
the line and all associated programs on the Program Explorer->Program Folders navigation bar.
Deactivating a line of business will remove the line and all associated programs from the Program
Explorer>Program Folders navigation bar.

You can activate and deactivate a line as many times as you need. Permissions and contents are not
removed when a line is deactivated. If you reactivate, the permissions and contents will be the same.

1.

2.

Navigate to the Line of Business that you want to activate or deactivate.

Right click to get the menu. For a System line, a deactivated line will have two right click menu
options; an activated line will have three menu options. For a Custom line, a deactivated line will
have three right click menu options; an activated line will have four menu options.

&» Manage LOB
New | [52 Edit

Show listing for lines:| All w

G Drescription Activated Type

1 Auto Edit S
E Home Artivate 'S
3 Life v

Figure 7 Selecting a LOB to Activate

To activate: Click Activate. The screen will refresh and the line of business that you activated will
now be displayed on the Program Explorer->Program Folders navigation bar. You also can
activate a line of business by entering the edit screen and selecting Activated.

&5 Manage LOB

New [ Edit

Show listing for lines:| All b
1D Drescription Activated Type
1 Auto v 5%5
2 Home 4 S¥YS
3 Life v 5%5
4 BOP Edit
3 Fire Deactivate
[ Umbrella Remaove All Programes
7 Valuables 5¥Y5

Figure 8 Selecting a LOB to Deactivate

To deactivate: Click Deactivate. The screen will refresh and the line of business that you
deactivated will not be displayed on the Program Explorer->Program Folders navigation bar.
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Removing All Programs from Line of Business

Any line of business can have all programs removed. Proceed with care, this action cannot be undone
and will remove all programs under that line. The sublines will remain in place and all globals under each
subline will remain. If you are unsure, you can deactivate a line of business. This will remove the
programs from usage but not from the system.

1. Navigate to the Line of Business where you want to remove all programs.
2. Right click to get the menu.

3. Click Remove All Programs. A warning message will be displayed. Click Yes to remove all
programs. Click No to cancel the action.

& Manage LOB
New | [E2 Edit
Show listing for lines:| All w
I Drescription Activated Type
1 Auto v 5%5
2 Home v S¥YS
3 Life Edit
4 BOF Deactivate
5 Fire Femuove All Frograms
[ Umbrella S¥YS

Figure 9 Removing All Programs from an LOB

Deleting a Custom Line

Custom lines can be deleted at any time. All associated contents for the line will be deleted as well.
Please verify this is the action you want to take. This action cannot be undone. Two warnings will be
given. You will need to refresh the screen to see that the line has been deleted.

1. Navigate to the custom Line of Business you want to remove.

2. Right click to get the menu.

3. Click Delete. A warning message will be displayed. Click OK to remove the line. Click Cancel to
cancel the action. A second warning message will be displayed. Click OK to remove the line.

99 Rules 5Y5
101 Errors and Omissions 4 CUSTOM
221 Fets 0 M
= Edit s
Selected Menu Item: Lins Of Business Listing Mumber of Lines: 32 Activate
Celete
—— @ Close |

Figure 10 Removing All Programs from an LOB
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AUDIT

RateManager can keep an audit log of user activity. Audit logs contain information such as action
performed, user ID, date and time stamp. Audits set to high will also track adding a user, editing a user
and deleting a user. Audit logs also can include program information such as program ID, program
version and line of business as well as element information.

The Audit tab contains a list of audits logs. The audit log feature has to be enabled at the group level. On
the Group Management tab, Tools—> Security-> Group Management, select the group where you want to
apply auditing. There are three options for auditing the group:

¢ None - no auditing will be done.
e Normal — all saves and deletes will be tracked.
o High — all new, creates, changes, saves and deletes for the group will be logged.

If the group(s) has high auditing, more audit logs will be created and you will have more types of actions
you can filter on.

= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

ORACLE" Insurance Insbridge RateManager Version: 04.05.00 Subscriber: alamere Ussr: Company Administrator
File Modules Tools Help
| Home | &7 Audit x = (@
H ] Audit

i = Fiter | #8 AuditReport | % Purge Al ) Refresh

Action Line Program Version Version Name Date Contrel Number -

New Algorithm 1 GLOBALS 4/11/2011 2:36:40 PM

Save Program Version 1 Bentonville 2 WM-2011.4 4/11/2011 2:32:52 PM

New Input 1 GLOBALS 4/11/2011 2:31:36 PM

User Logout 4/11/2011 1:37:14 PM

New Program Version 1 Bentonville 2 4/11/2011 1:36:51 PM PO9523698 1

User Login 4/11/2011 1:35:56 PM

User Login 4/11/2011 1:35:34 PM

New Program Version 1 Lake Charles 2 4/11/2011 1:33:44 PM Order &

User Login 4/11/2011 1:33:06 PM

New Program Version 1 El Paso 2 4/11/2011 1:32:13 PM Order 9578A2150

User Login 4/11/2011 1:31:34 PM

New Program Version 1 QKC 2 4/11/2011 1:29:58 PM CC ABC L2

User Login 4/11/2011 1:28:17 PM

Save Table Variable 1 GLOBALS 4/11/2011 1:26:09 PM

Data Import 1 Auto - alamere - ... 4/11/2011 1:25:51 PM

New Table variable 1 GLOBALS 4/11/2011 1:24:55 PM

New Category 1 GLOBALS 4/11/2011 1:24:14 PM

New Program Version 1 Austin 2 4/11/2011 1:23:15 PM CO 123

New Program 1 Austin 1 4/11/2011 1:22:19 PM

User Login 4/11/2011 1:21:45 PM

User Logout 4/11/2011 1:12:25 PM

New Program 1 Wichita 1 4/11/2011 1:12:18 PM

New Program 1 Topeka 1 4/11/2011 1:10:26 PM

New Program 1 KCM 1 4/11/2011 1:07:07 PM s

Page Size: | 1000 perpage v 1§ € & P Page 1 of 1 (Total Records:43)
3
v

< | >

Figure 11 Audit Tab
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Navigating to Audit

1. Select Tools2>Audit.

2. This will open the Audit tab.

FUNCTIONALITY

The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on

this tab.

Functions:

= Filter

Filter: Opens up the filter option. You can select fields to filter on. The entries you
make in the filter option will be the results returned. The results will be displayed in the
main body of the tab. Any field that does not match will not be displayed. Filters are
removed when you exit the tab or re-enter the filter option and remove the filter.

#=1 Audit Repaort

Audit Report: Opens up a full Audit Report for the audits currently being displayed.
Audits that have been filtered out will not be displayed.

Purge All: Purges all audits currently displayed. Results can be filtered for purging. If
you filter audits, only the audits that meet the filter criteria will be displayed. These

e o8 audits will be removed if you select to Purge All. If you select to purge all without a filter,
every audit will be deleted.
i) Refresh | Refresh: Refreshes the list of audits.
FIELDS

The main body of the tab displays the logs that have been created since the last purge. There are five
fields in the main body of the Audit tab.

Action: The action performed.

Line: The line of business. No Line means that this was a system action, for example, logging in
or out of the system.

Program: The name of the program where the action took place. No Program name means that
this was a system action.

Version: The program version number where the action took place. No Program Version number
means that this was a system action.

Version Name: The program version name assigned to the program. This is an optional field and
may not have an entry.

Date: The time stamp of when the action tool place.

Control Number: Displays any Change Control information.
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NOTE: If you have Auditing on and no results are being displayed, verify that the Insbridge Message
Service is running. Audit logs may not be displayed if the Message Service is not running.

Right Click Menu

There is a right click menu available on every audit log.

£= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

ORACLE Insurance Insbridge RateManager Version: 04.05.00 Subscriber: alamere User: Company Administrator
File  Modules  Tools  Help
[ Fome 1| & Audie x = &
| [ Audie
i = Filter | #B AuditReport | i Purge All | (§) Refresh
Action Line Program Version Wersion Name Dats Control Number -
User Login 4/11/2011 1:35:34 PM
New Program Version 1 Lake Charles 2 4/11/2011 1:33:44 PM Order 6
User Login 4/11/2011 1:33:06 PM M
New Program Version 1 Flpa 2 4/11/2011 1:32:13 PM Order 9578A2150
User Login Wiew Audic Report 4/11/2011 1:31:34 PM
New Program Version Delete Audit 2 4/11/2011 1:29:58 PM CC ABC
User Login 4/11/2011 1:28:17 PM
Save Table Variable 1 GLOBALS 4/11/2011 1:26:08 PM
Data Import 1 Auto - alamere - Globals 4/11/2011 1:25:51 PM
New Table Variable 1 GLOBALS 4/11/2011 1:24:55 PM
New Category 1 GLOBALS 4/11/2011 1:24:14 PM
New Program Version 1 Austin 2 4/11/2011 1:23:15 PM CO 123
New Program 1 Austin 1 4/11/2011 1:22:13 PM
User Login 4/11/2011 1:21:45 PM
User Logout 4/11/2011 1:12:25 PM B
New Program 1 Wichita 1 4/11/2011 1:12:18 PM
New Program 1 Topeka 1 4/11/2011 1:10:26 PM
New Program 1 KCM 1 4/11/2011 1:07:07 PM
New Program 1 KC 1 4/11/2011 1:06:22 PM
New Subline Folder 1 GLOBALS 4/11/2011 1:05:36 PM
User Login 4/11/2011 1:05:10 PM
User Logout 4/11/2011 1:04:55 PM
User Login 4/11/2011 1:04:31 PM
User Logout 4/11/2011 1:04:21 PM
Page Size: 1000 perpzge v | € € © P Page 1 of 1 (Total Records:48)
" ~
|Audit Report =
Action Information:
Acions  New Program Version -
User:  Mary Eliot
Date: April 2011 L:32PM
i Omergs7EA2ISO
Perrequest
Line:  Auko
Program:  Eieso 2
< | =

Figure 12 Audit Listing Right Click Menu

The right click menu contains two options:

e View Audit Report: This option will display the audit report for this audit log only, in a printable
form. If you do not need to print out an audit report, double click the log and view the audit details
at the bottom of the screen.

o Delete Audit: This option will delete the selected audit log only. Use this feature to delete logs
that will not be removed in a purge, such as purge logs and audits with Change Control entries.
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FILTERING

Filtering allows you to filter audit logs by specific criteria. When you select a filter, any audit logs with that
criteria will be returned to the screen. Results are listed newest to oldest. The results on the screen can
then be used to create an Audit Report or be purged.

- Filter Audit Results

Action: || |

Line Desc: -- Mo Filter -- [ Custom

Program ID:

Version Name:

Program Ver:

User LastMamea:

From Date:

To Date:

|
|
|
User Firstame: |
|
|
|
|

Control Humber:

@ Ok G, Clear | €) Close |

Figure 13 Filter Selection

Action: You can filter by words found in the action description. For example, Login, Save, Delete or
Control. You do not have to enter the entire phrase. You can enter New and any action description with
the word New in it will be returned. Your filter options will depend upon the level of auditing the group has.
If your group(s) has high auditing, more audit logs will be created and you will have more types of actions
you can filter on.

Line Desc: You can select an active line of business from the drop down menu or you can click the
Custom link to enter in your own description.

Program ID: You can enter in the exact program ID. Only exact matches will be returned.

Version Name: You can enter in the exact program version name. Be aware that program version names
are not required and are not unique. If you enter in 1, you may get many results for program version 1
from multiple lines of business and multiple programs. Only exact matches will be returned.

Program Ver: You can enter in the exact program version. Be aware that program versions are not
unique. If you enter in 1, you may get many results for program version 1 from multiple lines of business
and multiple programs. Only exact matches will be returned.
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User FirstName: You can enter in a user first name up to 20 characters. Only exact matches will be
returned.

User LastName: You can enter in a user last name up to 20 characters. Only exact matches will be
returned.

From Date: Dates must be entered in yyyy-mm-dd format. Only entering in a From Date will return audit
logs from that date until current. Date ranges can be returned by entering in both and from and to dates.

To Date: Dates must be entered in yyyy-mm-dd format. Only entering in a To Date will return all audit
logs from the beginning of the audit log until that date. Date ranges can be returned by entering in both
and from and to dates.

Control Number: You can enter in the exact Change Control number or tag used when creating the new
revision. This is helpful if you want to make sure all changes were done against a particular change order.
You do not have to go into each element to search. You can come here, enter in the change control
identifier and view the list here. You can also do an action filter by the word Control to get a listing of all
change controls.

To Set Filtering

NOTE: Line of Business 0 is Workflows. To search for Workflow items, you must do a custom search.
Change the Line Desc field to custom and enter in a 0. Click OK to search.

1. On the Audit tab, click FILTER. This will pull up a filter screen where you can enter criteria that
will narrow your audit results.

e You can choose one or more filters.

o Filters remain in place until your remove them or leave the tab.

o To clear afilter, click the Clear button. After you clear a filter, all Audit Logs will be
returned.

2. After you have entered your filters, click OK to view your results.

{= Oracle Insurance Insbridge RateManager, 04.05 - Windows Internet Explorer

ORACLE’ Insurance Insbridge RateManager Version: 04.05.00 Subscriber: alamere User: Company Administrator

Fle  Modules Tools  Help

| Home | G Audit X = (@
|15 Audit

i ¥ Filter | A% AucitReport 8 Purge All | () Refresh £

Action Line Program ersion ersion Name Date Control Number

New Program Version 1 Lake Charles 4/11/2011 1:33:44 PM Order 6

New Program Version El Paso 4/11/2011 1:32:13 PM Order 957842150

New Program Versicn OKC 4/11/2011 1:29:58 PM CC ABC

New Program Version Austin 4/11/2011 1:23:15 PM CO 123

4/11/2011 1:22:18 PM
4/11/2011 1:12:18 PM
4/11/2011 1:10:26 PM
4/11/2011 1:07:07 PM
4/11/2011 1:06:22 PM
4/11/2011 12:59:16 PM
4/11/2011 12:57:22 PM
4/11/2011 12:55:21 PM
4/11/2011 12:55:07 PM

Austin
Wichita
Topeka

KCM

KC
Bentonville
Lake Charles
El Paso

OKC

New Program
New Program
New Program
New Program
New Program
New Program
New Program
New Program
New Program

R R SR SRS S E R VRN

Figure 14 Filtered Audit Listing Results
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AUDIT REPORT

An audit report for all audit logs currently displayed on all pages by filter criteria can be produced. If you
want an Audit Report for all audit logs, make sure the filter has been cleared. If you want an audit report
for a specific type of audit log, make sure to filter by that criteria. For Example, if you want the audit logs
from a particular day forward, then enter that day in the From Date on the Filter. All the audits from that
day and forward will be listed. The audit report is a maximum of 15 pages.

& Oracle Insurance Insbridge Document Viewer -- Webpage Dialog

ORACLE Audit Report 41152011 04:38 PM
INS URANCE
ACTION: User Logout
Action Information:
Action User Logout
User Mary Elliott
Date Apr 14 2011 11:15AM

Control Number

Control Note

Element/item Information:

Description Mary Elliott
Revision
ID

@ Close |

Figure 15 Audit Report

Creating an Audit Report

To create an Audit Report, enter in the criteria you want to filter by and click Audit Report. Reports will be
displayed in the Insbridge Document Viewer. These reports are read-only. Reports can be saved to your
local hard drive or network or printed. No editing can be done on the Insbridge Document Viewer.

NOTE: When you do a “Save As” from the Insbridge Document Viewer, you should rename the file. By
default, when you go to save a file in the Insbridge Document Viewer, everything will be named
“InsbridgeDocument”. It is recommended that you re-name the file.
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Report Details

The report will contain details for each of the audit logs included, starting with the newest. Each log will
have action information, defining the action taken, the user and the date. Program information, such as
LOB, program, program version, and program ID, may be included. If applicable, element/item information
including description, revision and ID may be included.

NOTE: OBI Publisher must be installed and running in order for Program and Program Version Reports
to be displayed. If you receive an OBI Publisher error, please contact your system administrator.

Audit Preview

To view a specific audit, double click the line. The audit report details will be displayed in Preview
Window located in the lower portion of the tab.

lAudit Report

Action Information:

Program Information:

Element/liem Information:

< >

Figure 16 Audit Log Preview Screen

The preview window can be sized by dragging the separation bar between the audit list and the preview
window. The preview window will update to show the currently selected audit log.

NOTE: If logs are not displayed, please verify that the Insbridge Messaging Service is on. If the Insbridge
Messaging Service is off, logs will not be displayed.

Individual logs can be viewed or deleted.

PURGING AUDIT LOGS

Audit logs that do not have a change control can be purged at any time. Purge All will remove all audit
logs currently displayed on all pages by filter criteria. For example, if you have run a filter for all logs
created on June 23, 2010, the screen will display all logs created on that day only. The logs may consist
of one page or many pages. If you click Purge, all logs for June 23, 2010 without change controls will be
purged. No other logs will be purged. To view remaining logs, clear the filter.

If you want to purge all audit logs without change control, do not place a filter on the list. If you only want
to purge selected items, place a filter on the list. Purge will only remove the audit logs that are displayed
on the Audit Listing screen. If you want to remove one audit, use the right click menu to delete.
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To Purge Bulk Audits

1. If you have a specific audit type or group of actions you want to remove, set a filter for the bulk
audits you want to remove.

2. When the audits you want to remove are displayed, click PURGE ALL.

A Confirm -- Webpage Dialog @

™ Purging the audit listing removes the listing
y from disk permanently! Are you sure you
want to do this?

2@ Ok | 3 cancel |

Figure 17 Purging an Audit List

3. Click OK to remove the all audits without change control currently displayed. Click Cancel to
return to the previous screen.

NOTE: Purge Logs and Change Control Audit logs will not be purged in bulk. These logs must be deleted
one at a time using the right click menu.

To Delete One Audit

1. To remove one single audit that is no longer required, highlight the audit. Audits with change
control can be deleted using Delete Audit.

2. Right click and select DELETE AUDIT from the menu.

A Confirm -- Webpage Dialog

™ You are about to delete this audit log. Are
_!_/l you sure you want to do this?

2 Ok | 3 cancel |

Figure 18 Purging an Audit List

3. Click OK to remove the log. Click Cancel to return to the previous screen.
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IMPORT PROGRAMS

The Imports screen allows you to import all elements related to a program including the following:

e Global Input Variables

e Global Result Variables

e Local and Global Mapped Variables

e Local and Global Calculated Variables
e Local and Global Algorithms

e Sequencing

e Program Versioning

o Categories

(= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

ORACLE" Insurance Insbridge RateManager Version: 04.05.00 Subscriber: alamere User: Company Administrator
Fie Modues Took  Help
‘7 Home ] [ Import Programs X = ¥
I ‘ % Import Programs
1% tmport | 3 pelete | | ) Upload From Fie | B save ToFile | i) Refresh ©
Export Name Program Name Loe Export Date Size
Selected Menu Ttem: Import Programs Number of Program Imports Listed: 0

Figure 19 Imports
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Import Program can only create a new program, with a new program ID. You will not be able to restore
over an existing program for safety reasons. You can delete the incorrect program and import the correct
program.

FUNCTIONALITY

The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on
this tab.

Functions:

Import: Opens the Program Import Wizard. This wizard will guide you through the

b Import | .
=1 Ame import process and allow you to create new elements.

3€ pelete | Delete: Removes the selected program from the Import Programs tab.

1% Upload From File | Upload From File: Uploads files from your local hard drive or network.

Save To File: Allows you to save an import program to your local hard drive or

5 To Fil
( saveToFie network.

ifi) refresh | Refresh: Refreshes the list of imported programs.

FIELDS

The Import Programs tab displays the programs that have been imported and are ready for importing.
There are six fields in the Import Programs tab.

Check box: A check here will select the program from importing or deletion.
Export Name: The new name of the exported file. This name cannot be changed.
Program Name: The original name of the exported file.

LOB: (Line of Business) — The line of business where this file was exported from.
Export Date: The date the file was exported.

Size: The size of the file.

Navigating to Import Programs

1. Select Tools>Import Programs.

2. This will open the Import Programs tab.
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Right Click Menu

A right click menu is available for exported files.

File Modules  Tools  Help

| Home | % Import Programs X
*
({3 Import Programs
: & Import x Delete & Upload From File [ save To File @[ﬂ Refresh :
e
Export Name Praogram MName LOB Export Date Size
01224567 m_=zuto Auto Apr 15 2011 4:17AM 121 KB
Gek Summary
D vin progran grami Auto Apr 12 2011 6:12AM 134 KB
Irnport Prograrm
D programl programl Auto Apr 11 2011 4:40AM 125 KB

Figure 20 Right Click Menu for Import

The right click menu contains:

Get Summary: Pulls up the summary page from the program.

Import Program: Allows you to launch the import wizard.

Get Summary

Get summary displays a summary report of the export including line, program name, program ID and

export information.

e | Exported Program Summary

Exported Program Summary

Description of exportad program.

Line Of Business: Auto

Program Mame: program_aukto

Program ID: 623457974

Date/Time Exported: Apr 15 2011 4:17AM
Export By: Company Administrator
Export Mote:

Version Included:
Version 1

@ Close |

Figure 21 Get Summary
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IMPORT WIZARD

The Import Wizard allows you to import programs into RateManager. The Import will be into the same line
of business that the program has been exported from. This is done automatically and you do not need to
make any selections.

If the exported line is not activated in the importing subscriber's RateManager, the Exported Program
Summary will display No LOB found for the Line of Business information. You will have to activate or
create the line of business before this program can be imported. If you attempt to import a non-activated
line, an error message will be displayed. The error message will display the LOB ID number that you
need to activate or create.

Sublines and Imported Programs

Lines are separated into sublines. Sublines are classifications that fall in between lines and program
folders. Sublines will allow you to distinguish program sources and also keeps the globals unique within
that subline. Globals are subline specific and are not shared across sublines. There are two types of
sublines, default and template generated.

1 - Indicates the Default subline
¥Z - Indicates Template generated sublines

You will have one default subline. This is the subline created for your subscriber ID. Any program in any
subline can be exported to the Import tab. Exported programs can be saved to your local hard drive or
network and then imported back in to your RateManager system or another RateManager system.

Template generated sublines are created when you apply a template or import a program that was
created outside of your subscriber ID. Programs exported from different subscribers will create a new
subline when imported. For example, if you import a template from subscriber Alamere, you will create a
subline Alamere. If you import another template from subscriber IGBU, you will create another subline
IGBU. You can have many template generated sublines.

Only one subline per source will be created. Templates and Imports will reside in the same subline. A
Program folder will be created with each subline. Additional folders and programs can be added to the
subline.

Launching the Import Wizard

To Import a program, select an export program from the list. If no export programs are listed, you can
upload from a file or return to the folder and export one. Click IMPORT. The wizard will launch in a
separate window.

Throughout the Import:

NOTE: A black arrow ¥ indicates the current step in the import progress

A green checkmark ¥ indicates that the step has been completed.
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Import Wizard Screen 1 —Welcome

The welcome screen gives you information about the import functionality and prompts you to backup the
database before executing the import. A backup is strictly for safety reasons, and while not required, it is

recommended.

e | RateManager Program, Import Wizard

» Welcome to the RateManager - Program Import Wizard

This wizard helps you to import RateManager programs.

It i5 recommended that a database backup is created before executing a Program Imnport.

["_.__l'.) Help | Hext 5 Cancel @ |

Figure 22 Import Wizard, Screen 1

Click NEXT to continue.

NOTE: At any time, you can click CANCEL to cancel out of the wizard. Click HELP for online help.
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Import Wizard Screen 2 — Configure Program Import

The Configure Program Import screen allows you to enter in a name for the import and select the folder
where the import can be brought into. You also can choose whether or not you want to see every screens
progress or only the issues that need to be resolved.

The left side of the screen will let you know the progress of the import process.

e | RateManager Program Import Wizard

p Configure Program Import Conﬁgure Program Import
Configuration of newly import program
Wity Import [nfo

Fiesolve Categories Campany Name: | DallzsCounty b |

Global Input % ariables

* News Program Mame: |]rnpcu|'t of [CustomFit 2 AL Auto] |

Global ResultVarables

Global Mapped Yariables Select Program ID: Aute Select » | | [ Check If Used

Global Caleulated YV ariables

Global Algorithms Show anly data that
. neads to be resclved: @
Completing |mport Process

Show all data: "3

(2) Help | Back 4 Hext 3 cancel () |

1. Select the folder that the program is to be imported in to.
2. Enterin a New Program Name if needed.

3. Select if you want to enter a configurable program ID number or if you want to the system to auto
select one for you. You can check if the ID is used or available by entering your program ID and
clicking the Check if used button. An answer will be returned to you immediately.

4. Next you can choose:

o If you want the import wizard to proceed from this screen and only stop on items that
need to be resolved.

o If you want the import wizard to proceed from this screen and stop on every screen that
has applicable variables, regardless if the variables and/or algorithms need to be
resolved.

5. Click NEXT to continue.
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Import Wizard Screen 3 — Verify Information

The Verify Information screen is a summary of the program to be imported, and the naming conventions.

This is the same information you can get by right clicking on the Export Program name and selecting Get

Summary.

e | RateManager Program, Import Wizard

# Configure Program Impart

p Yerify Import Info
FRezolve Categones
Global Input 3 ariables
Global Result Y arisbles
Global Mapped Yariables
Global Calculated Y arniables
Global Algorithms

Completing Import Process

Verify Information
Verify the choices made in the wizard and click Next,

QLD Program Name: CustomFit 2 AL Auto
Mew Program Name: Import of [CustomFit 2 AL Auto]

Mew Program ID: Will be automatically selected during import.

lf‘?_) Help |

Cancel @ |

Figure 23 Import Summary Screen

1. Verify the data before continuing with the import. This screen is the last place you will be able to
go backwards and make corrections before the import commences.

2. Click NEXT to continue.
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Import Wizard Screen 4 — Resolving Categories

If you have selected to stop or if an issue has risen, then the Resolving Categories screen will be
displayed.

e | RateManager, Program Import Wizard

» Configure Program | mpart Resolving Categories -
Select the existing category that matches the imported
& erify Import Info

- Importad Category Existing Category Action Status
» Reszolve Categories

\iclations -- Do=s Not Bxist -- Cr=at= Not Found
Global InDUt Variables Irsur=dOrPrincipal -- Dioes Not Exist -- Create Not Found
Global Result Wanables Garagirg Location - Diz== Nt Exist -- Creste Not Found
Global Mapped Variables SpecificDats - Doms Nt Exist -- Craat= Net Found

_ Imported
Global Calculated Y ariables Path: SpecificData
; Existing

Global Algarithrns Path: Creste 3

Completing Import Process

Note: Double-click on selected row to see category's full path

(2) Help | Hext 3 | cancel €3 |

Figure 24 Import Wizard Resolving Categories

Category Rules:

o If a category does not exist, the system will prompt you to create it.

o If you would like to map an existing imported category to a different category, you will be able to
select from a list of existing categories via a category drop-down.

e Valid Statuses:
Not Found: If an imported category is not found in the existing database the status will be
“Not Found”
Found: If an imported category is found in the existing database the status will be “Found”

e Valid Actions:
Create: If the user would like to create a new category the action shall read “Create”
Replace: If the user would like to replace an imported category with an existing category the
action shall read “Replace”
None: There is no action taken, which is the default when a category is found.

3. After resolving any issues, click NEXT to continue.
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Import Wizard Screen 5 through Screen 9

Screens 5 through 9 all function in the same way, only stopping when an issue arises. In order to
continue, the issue must be resolved.

Screen 5 — Global Inputs

Screen 6 — Global Result Variables
Screen 7 — Global Mapped Variables
Screen 8 — Global Calculated Variables
Screen 9 — Global Algorithms

a RateManager Program Import Wizard

¥ Configure Frogram Import Resolving Global Inputs Variables ...
. Select the existing Global Inputs that match the imported Global Inputs
¥ ety Import Info
. Imported Global Input Existing Glabal Input Action Status
@ Fesolve Categories E E < E
OriginalTermAmount | Create W | Crmats Mot Found :
p Global Input ¥anables
ContractNumber | Create W | Crmate Mot Fownd =
Global Result Y arisbles PricrCami=rS4 | Creats W | Create Mot Found
Global Mapped YV ariables PrizrCarriarSaN | Crezte w | Crests Not Found
Global Calculated Y ariables RatingStats | Create “ | Creats Nt Foung
Elobal ;’-‘«Ignrithms CreditSoom | Create W | Crmatm Mot Fownd
Completing Impart Process Effectivalt [ Creste v|  cre Nat Fourd
ExpirationDt | Create W | Crmats Mot Fownd
Ge=nder(d | Creste Vl Cre=at= Mot Found
ManEntrPremInd | Create W | Crmats Mot Fownd
ManufacturenMake= | Creste Vl Cr=at= Not Found
Model | Create Vl Crmats Mot Fownd
Originallno=ptionDt | Create W | Crmate Mot Fownd
Lapz=limit | Create W | Crmats Mot Found
Prior BlLimitsPerPerson | Create W | Crmate Mot Fownd
Dirimr mm ire A Sina e imit [Pa— |  Crmnta it Frumd e
| Hext 5 | | cancel 3 |

Figure 25 Resolving Issues on the Import Wizard

Screens 5 through 9 have the same statuses and actions.

o Valid Statuses:
Not Found: If an imported Global Variable or Algorithm is not found in the existing database
the status will be “Not Found”
Found: If an imported Global Variable or Algorithm is found in the existing database the
status will be “Found”

o Valid Actions:
Create: If the user would like to create a new Global Variable or Algorithm the action shall
read “Create”
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Replace: If the user would like to replace an imported Global Variable or Algorithm with an
existing Global Variable or Algorithm the action shall read “Replace”

None: There is no action taken, which is the default when a Global Variable or Algorithm is
found.

2 RateManager, Program Import Wizard

¥ Configure Program Import Resolving Global Inm—
_ Select the existing Global Inputs th' g e 2
& ety Import Info pU=e
BaseRate
. Imported Global Input B BILimit Action Status
¥ Fesolve Categories BIMin
OriginalTermAmount . Crmate Not Fouwnd -~
. 3 CancellztionDate —
p Global Input Yariables n
_ ClassCode _
ContractNumber COLLCov Create Mot Found
Blobal Fesultarisbles FrinrCarriarSh CompanyCode Crests Mot Found
. CompanyMName
Global b apped ' anables PrisrCarierSaN COMPCoy Creatz Nat Found
. Cowveragel
Global Calculated Variables RatingStats Coverage? Crasts Mot Found
) CowverageDesc
Global Algonthms Creditsears EffectiveDate Crast= et Found
Effactivelt ExpirationDate Crast et Found
Completing Impart Process =t GoodDriver mreaiE = Eune
ExpirationDt g?gj:éuoiint Crmate Mot Found
Genderld HomeCwiner Craats Mot Found
LimitCode B
ManEntrPremInd LimitDedDesc Crmate Mot Found
ModelYear
Marulacturer Maks MPSymibcl Creais Mot Found
MultiCar
Mod=] -No Input Crmate Mot Found
- ) PaidInFullDisc
OriginallnceplicnDt POCov At Creats Mot Found
Lap==Llimit E:‘ﬁr?::d uctible w Crmate Not Found
Prior BILimitsPerferson Crezte .V,,- Creats Mot Fownd
Erinr Cmmbired Sin e it Jp— | rrnta Hint Frort b
(Z) Help | Hext 3 | | Cancel ) |

Figure 26 Replacing a Not Found Input with an Existing Input
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Import Wizard Screen 10 — Processing Immediately

The import will immediately process. You will receive a processing screen.

a RateManager Program, Import Wizard

& Configure Pragram Impart
¥ ety Impart Info

v Fesolve Categories The remaining portion of the Import wil take approximately 2.47 minutes.
¥ Global Input Wariables

@ Global Result Variables

¥ Global b apped ¥ aniables
o Global Caloulated Yariables
¥ Global Algarithme

Completing Impaort Process

| Hext 3 ; ‘ Cancel@l

Figure 27 Processing Time for Import
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Import Wizard Screen 11 - Finished

When the process is finished, you will receive a screen letting you know if the import was successful or
failed.

e | RateManager Program Import Wizard

# Configure Program Impart
' Veiify Import [nfo

¥/ Fesolve Categoies Import Has Completed Successfully
# Global Input Y ariables

¥ Global Result Variables

# Global Mapped Variables
# Global Calculated Yariables
¥ Global Algorithms

# Completing Impart Process

(2) Help | Close ) |

Figure 28 Successful Completion of an Import

Global Imports

When a Global Variable or Algorithm is imported inside a program, it can not been undone via the import
process. By default, the import does not override any conflicting data.

There is no indication in the RateManager Global Variable or Global Algorithm listing that a Global
Variable or Algorithm has been imported.
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Deleting Programs

Programs can be deleted from Imports at any time.

To Delete:

1. Select the Program.

2. Click DELETE. A warning message will be displayed.

2 Confirm -- Webpage Dialog

™ Are you sure you would like to delete the
_!'_,/l selected Program Export(s) ?

2@ Ok | 3 cancel |

Figure 29 Deleting an Export Program Warning Message

3. Select OK to delete. Click Cancel if you do not want to delete this program.

Upload Files

Program files can be uploaded directly into Imports. You can upload a program export from a .pxf file.
Please note that all .pxf files are encrypted. You can upload any program from any line of business.

To Upload a File:

1. Click UPLOAD FROM FILE. A separate popup will be displayed.
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A
Upload Program Export File

Fle: | | EEiigs .9

S

[3 upload | €) Close |

Figure 30 Uploading Program

2. Click the Browse... button to access your computers dialogue box.

Choose file

Laak in: | |~ Exported Progams ﬂ = |-=j€ B~
2 E abandDoveraged |2 Test
: I'é_“"J abandDcoverageb

My Recent [£] aDandoCoverageC
Documents = ca-versionz S51507-2008.srtp

'T' IOM_PUB_S5_2ecfb102846b4cdsbabessssf72bech2. srtp
IOM_PUB_S5_bd443d05bazS45a2b22b1dab781b790d. srtp
Desktop programExport_Expart of [FireMw-875217 pf
. programExport_Expart of [La].pxf
__.-} programExport_Expart of [0k, pxf

programExport_Export of [Skyl]. pef

programExport_Export of [SkyFIREL], pef
programExport_Expart of [Vijee_Sourcel]. puf

5%! programExpart_Expart of [Wijee_Source], pxf

EJ replaceCostCovCFactarFireLightning
2 Result_DOCSL20KG_1_17_1_20071018_110047_

G - '

2
My Metwark.  File name: ||:|r|:|g|ramE wport_E spart of [SkeFIRET] ﬂ Open |
Places
Files of type: |1l Files [%) | Cancel

Figure 31 Selecting File to Upload

3. Select the program you want to upload and click Save. You will be returned to the Uploading
Program box.

4. Click the Upload button. The process will begin.

When the program is finished uploading, the popup will close and the program will be listed on the Import
Program screen.
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Saving Files

You can save a program in the Import Programs tab as a .pxf file on your local hard drive or network.

To Save a File

1. Select the file you want to save.

2. Click SAVE TO FILE. Your computers dialogue box will be displayed.

File Download X

Do you want to save this file?

@ Mame: programExport_Export of [Vijee_Sourcel].pxf
Type: Unknown File Type, 6.46 KB

From: southern

Save ]| Cancel |

harm your computer, |f pau do naot trust the zource, do not save this

@ YWhile filez from the Intermet can be uzeful, zome files can potentially
file. "hat's the nizk?

Figure 32 Saving a Program

3. Click Save and select the folder and location where you want to save the program.
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MIGRATE WORK FILES

This feature will migrate work files from a previous version of RateManger to release 4.5. Work files are
rating, pricing, mapping and template files used in various areas of RateManager such as Impact

Analysis, Library and Testing. Migrating files will allow users to access work files that were available in a
previous release of RateManager. If you do not migrate work files from previous versions, users will not

have access to them.

MIGRATING FILES

Prior to migrating files, please create backup copies of the files to be migrated. This will require access to
the server were RateManager has been installed.

[C5) Documents and Settings
5 Downloads
0 1386
15 Inetpub
|5 InsbridgePackageLacation
= |5 Program Files
125 cmak
IE5) Common Files
I3 ComPlus Applications
E I5) InsBridge
15 com+
IC5) Framework
15 soK
IC5) SoftRater
I Wehbs
1) IBFA
—eTBOLL_
I RM310
15 rM311
IC5) RM312
[C5) Internet Explorer
IC5) Mcafes
125 MSBuild
1) MSEML 6.0
E] MetMeeting
125 online Services
=I5 racle
= ) 1GEU
= ) Insbridge
1= comM+ o
IC5) Framework
15 soK
IC5) SoftRater
=I5 Wehbs
) IBFA
[ IR

() RM4

The location of previous RateManager installations:

-—— 1+ Program Files\InsBridge\Webs\RM:xoo

where x0¢ equals the version number

The current location of RateManager:

Program Files\Oracle\IGBU\Insbridge\Webs\RM4

() RM313

-
ey

1

File Edit Wew Favorites Tools  Help | !,'
) Back = €3 - 5 | - Search |ﬁf Folders | -
Address ID My Documents j e
Folders X | _Mame <+ | Size | Type | Date Madified
[=] “e Local Disk {C:) ;I
@ db&1b37074578Fcd9f5c508

Figure 33 Location of WorkFiles

48



Chapter 5 — Migrate Work Files

The location of the files to be migrated and the exact file name will depend upon what version of
RateManager you want to migrate. There are two possible locations.

For Release 3.12 and earlier:

o File Name: WorkFiles
e Location: \Program Files\InsBridge\Webs\RMxxx\WorkFiles

Where xxx is the version number, i.e. 310, 311, 312
For Release 3.13:

e File Name: Workfiles
e Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM313\Workfiles

Copy all work files for every version to be migrated and store in a safe location. In the unlikely event that
an error with the migration occurs, you will have backup files that you can place directly in the
RateManager (RM4) Workfiles location or restore to the previous version.

WARNING: Workfiles should be migrated after the initial upgrade has been run. Running the Migrate
function after users have accessed the system may result in 4.5 workfiles being overwritten.

Performing the Migration in RateManager

This migration process will move rating, pricing, mapping and template files from a previous version of
RateManager to the current RateManager version. You can select one version that you want to migrate. If
you have more than one version to migrate, you must perform the migration manually. Please refer to the
Installation and Upgrading Guide for instructions.

1. Select Tools>Migrate Work Files. A separate screen will be displayed.

3 - Wehbpage Dialog

-} Migrate Work Files

Migrate files from: | ERE]

This migration process will move Rating, Pricing, Mappings and Templates from a previous version of
RateManager that you selected to current RateManager, This process could take a few minutes to
complete, An alert box will appear when the process has completed.

Miglmel 3 Close |

Figure 34 Migrating Work Files

2. RateManager will determine the possible version to migrate. Select the version you want to
migrate. Only work files from the selected version will be migrated.
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3. Click Migrate.

2 Confirm -- Webpage Dialog

™ Al current Rating, Pricing, Mapping and Template files will be deleted in order
y to migrate the files from the previous RateManager. Do you want to
. continue?

2 Ves | @3 He |

Figure 35 Confirming a Migration

4. Say Yes to migrate. If you are unsure about the action you want to take, click No to stop the
migration process.

The migration will begin. This process could take a few minutes to complete. When all files have been
migrated, an information notice will be displayed.

™ The process has compleked,

'y

Figure 36 Successful Migration

5. Say OKto close the screen.

Manual Migration

A manual migration must be performed under select circumstances. All versions must be on the same
server. If you are working with two separate machines, you must perform the migration manually. A
RateManager migration will perform a copy and paste of the WorkFiles on the server then the previous
versions WorkFiles will be deleted. This means that the version you select to be migrated will have the
WorkFiles deleted from the server. This cannot be reversed. Make sure this is the action you want to take.

If you have more than one version where you want to migrate files, you will have to perform the migration
on the server. DO NOT USE RATEMANAGER TO MIGRATE MULTIPLE VERSIONS. Only one version
can be migrated. If you attempt to migrate more than one version, you will write over any data with the
version that you are migrating. For example, if you migrate version 3.12 and then migrate 3.13, any
information from 3.12 will be written over with the information from 3.13. If you have more than one
version to migrate, you must perform the migration directly on the server.
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Verifying Migrated Files in RateManager

Migrated files will be available in the same areas.

> Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

ORACLE’ Insurance Insbridge RateManager
File  Modules Took  Help
|_ Home _| Impact Analysis x
| 2" Batch Files
@ Run Batch File | (2 Open Batch File ~ x Delete Gﬁ Refresh ©
e[| versonOverndes || Include Debug Reports ] ScftReter Environment Override:
File Hame Date Modified
D \\Ibru313\cs\shared\TestCases\LOB2\Group1\*.xml| 2010-10-11T14:17:58 2
[ \\Ibru313\cs\shared\TestCasas\LOBL\=.xmI 2010-10-11T14:17:22
[ \WIbru313\cs\shared\TestCasas\LOB11266001552_01\*.xml 2010-10-11T14:12:46
[ \\Ibrua13\cs\shared\TestCasas\LOB11266001552_01\%.xml 2010-02-12T13:40:25
[ \WIbru313\cs\shared\TestCases\LOB2\Group4\*.xml 2010-02-09T11:56:15
D \\Ibru313\cs\shared\TestCases\LOB2\Group3\*.xml 2010-02-09T10:51:43
[] \\Ibru313\cs\shared\TestCasas\LOB2\Group2\=.xml 2010-02-09T10:51:22
v
Debug | File Hame Run By Date Run Policies Size
O Groupl_3.13.6 Company Administrator  2010-10-11T14:159:20 s0 518 KB A
O LOB1_3.13.5 Company Administrator ~ 2010-10-11T14:18:58 EH 410 KB 1
D 266001552_01_11-13-... Company Administrator 2010-10-11T14:12:48 1 5 KB
[J @ 25500155201 11-13-.. Company Administrator ~ 2010-10-11T14:01:03 1 432 KB
D 266001552_01_11-13-... Company Administrator 2010-10-07T15:36:00 1 5 KB
[J [ 25500155201 11-13-... Company Administrator ~ 2010-10-07T15:35:18 1 432 KB
[J & 26600155201 11-13-... Company Administrator ~ 2010-10-07T15:22:15 1 432 kB
O 266001552_01_11-13-... Company Administrator  2010-10-07T15:20:11 1 B
[J & 266001552 01 11-13-... Company Administrator ~ 2010-10-07T15:19:34 1 432 kB
O 288001552_01_11-13-... Company Administrator ~ 2010-10-07T14:58:18 1 SKE
[J @ 256001552 01 11-13-... Company Administrator ~ 2010-10-07T14:57:35 1 432 KB
[] & 255001552 01_11-13-... Company Administrator ~ 2010-10-07T14:30:41 1 432 KB
O 266001552_01_11-13-... Company Administrator  2010-10-07T14:49:52 1 sKE
O LOB1_3.13.5 Company Administrator  2010-10-07T14:44:20 EE 410 KB
O BATCH REGR TEST_20... Batch Regression Test ... 2010-08-11T18:45:52 1 10 kB
D BATCH REGR TEST_20... Batch Regression Test . 2010-08-11T18:45:52 1 10 KB
O BATCH REGR TEST_20... Batch Regression Test ... 2010-08-11T18:45:52 1 11kE
D BATCH REGR TEST_20... Batch Regression Test ... 2010-08-11T18:45:51 1 10 KB
O BATCH REGR TEST_20... Batch Regression Test ... 2010-08-11T18:45:51 1 10 kB
O BATCH REGR TEST_20... Batch Regression Test ... 2010-08-11T18:45:50 1 10 KB v
Selacted Manu Ttem: Bstch Fiks
Batch Files | Reporting |

Figure 37 Verifying File Migration in RateManager

To verify that work files from a previous version have been migrated, enter an area where these files
would be used, such as Impact Analysis.

The tab will refresh with all available files. Your files from previous versions will be listed.
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Verifying the File Migration in the Server

Migrated files will be moved from previous releases into the updated RM4 Workfiles location.

[ C:',Program Files',Oracle’, IGBUInsbhridge',Webs',RM4" Workfiles',Mappings', Input',Custom

File Edit Wiew Faworites Tools  Help | ,'
Q) Back ~ ) - 1? | ' Search |[|'_" Folders | [
Address I]j| Ci\Program Files\Oracle IGBU Insbridae)websiRIM4 ) Warkfiles| Mappings! Input i Custom j G0
Folders ¥ | _Mame = | Sizel Type | Drate Modified |
) AU ;I i 313Auto Training Manual Tables, xslt 1KE ¥5SLT File 1/10§2011 1:13 AM
E [ rM4
[ Activer
[T App_Themes
[T bin

5 Components
E] Connecktars
) Controls
ﬁ] Css
(£ Images
[ Includes
[C3) Licenses
[C5) Logindpps
5 Main
5 Modules
I3 Script
ﬁ] Service References
[ Utils
[ videos
[C5) Web References

2k &L
] Expoarts
I ImportDataFiles
=l IC3) Mappings
= C3) Input
Custam
T3 Library
E £ Output
[T Custom
I3 Pricing
I Rating
I Releases
t] Reports
I Templates —
50
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Figure 38 Verifying File Migration at Server Level

You can verify that files have been moved by looking in the
\Program Files\Oracle\IGBU\Insbridge\Webs\RM4\Workfiles folder.

Work Files can be moved manually. Please refer to the Installation and Upgrading Guide for instructions.
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Migration Messages

If the migration has already been done, a message will be displayed.

2 -- Webpage Dialog

™ The files don't exist arvy more, You may have
already run the migration process, Unable ko
move directories, Thread was being aborted,

' Ok

Figure 39 Migration Already Performed

If the migrating tool does not find any files to migrate, a message will be displayed.

2 -- Webpage Dialog

™ Could not find a part of the path 'C:PROGRAM
FILES\ORACLEVIGELNINSERIDGE Wabsi M3 15
Vworkfiles\Rating'. The process has completed,

' Ok

Figure 40 No Files to Migrate
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SECURITY

Any administrator may configure RateManager security settings. Usernames and groups can be created
and system rights assigned. Groups can be created to grant users access to specific lines of business
and specific screens within that line of business (variables, algorithms, etc.), with or without write access.
Groups also can be given access to specific modules, Testing or Impact Analysis.

Security can be found on the Tools menu. There are three options you can select:
e User Management

e Group Management
o Session Management

USER MANAGEMENT

The user management tab allows an administrator to add, edit and delete users. This portion of
RateManager is only available to users who are members of the Administrator group.

= Dracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

Fle Modues Tools  Help

[ Home | & usertanagement x = (@

I | User Management
[ Mew | (22 edit | 3 Delete | B Refresh

Hame Contact Info Last Login

Company Administrator Mar 7 2011 5:554M

Selected Menu Ttem:  User Management

Figure 41 User Management Screen
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From here, you can:

Add a User

Edit a User

Delete a User

Reset a User Password

Company Administrator will be the only user in a new system. All other users must be created. The
Company Administrator cannot be deleted nor have their rights edited.

Navigating to User Management

1. Select Tools=>Security>User Management.

2. This will open the User Management tab.

FUNCTIONALITY

The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on
this tab.

Functions:

Mew | New: Opens up the Create User tab where new users can be added to the system.

Edit: Opens up the Edit User tab where user information can be updated and user

[ Edt password reset.

€ pelete | Delete: Deletes the selected user.

iifi) Refresh | Refresh: Refreshes the list of users.

FIELDS

The main body of the tab displays the users that have been created. There are three fields in the main
body of the User Management tab.

Name: The first and last name of the user.

Contact Info: The phone number and email address of the user. The email address will be
hyperlinked, allowing you to create an email for this user.

Last Login: The time stamp for the last date and time the user logged into the system.
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ADDING A USER

New users can be added from the Add User tab. All new users will be assigned the default password,
password. New users should log in as soon as possible and change their password.

There are two icons and two buttons located on the tab.

Required: A red asterisk indicates that this field is required. You will not be allowed to
save your entry unless all the required fields are complete.

Information: Click the information icon to see more information about the entry.

Select Arrow — Move Left: The column on the right lists the available groups. The
Select Arrow — Move Left will move the selected group over to the left side column.
Upon saving, the user will belong to that group.

Select Arrow — Move Right: The column on the left lists the group(s) the user is

over to the right side column. The user will no longer belong to that group.

‘%:-’? Save

Save: Saves your entry. The Save option is located in the lower right hand corner of the
tab.

9
- | currently a member of. The Select Arrow — Move Right will remove the selected group

@ cancel Cancel: Cancels any changes and returns you to the User Management tab. The

Cancel option is located in the lower right hand corner of the tab.

To Add a New User

NOTE: Prior to creating a user, make sure you have your user groups created.

Navigate to the User Management tab.
Click NEW to open the Add User tab.

Select the Group(s) the new user will belong to by selecting a group or groups from the Select
Groups list and then clicking Select Arrow — Move Left. Upon saving, the user will belong to that
group.

Select the Company the user will belong to from the drop down listing.

Subscriber information may be needed by users when logging into the system. If more than one
subscriber was created, users must be directed to the subscriber where their logins were created.
Subscriber information is necessary for custom XML creation and testing and is also needed for
Libraries.

If you have not created subscribers in IBFA, you will not be able to assign users to a company.

Enter a First and Last name for the user in the appropriate text boxes.

Enter a Username for the new user. The username must be at least six, but fewer than twelve,
alphanumeric characters and can include an underscore (_) or period (.).

Enter a Department for the user.
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8. Select whether the new user is a Network User by selecting True or False from the drop down. If
you select True, the user's credentials (username and password) will be validated using Windows
Authentication Tokens. The username must match the network user ID. If you select False, the
user must enter a valid username and password via the RateManager login screen.

9. Optionally, enter a Phone Number and Email Address for the new user.

10. If you want the user's password to expire, click the box next to Password Expires. The
Preferences screen will contain the number of days required for a password change.

11. When you are finished, click SAVE. The user will be added to the system and the user list will be
updated. The new user can now log in using the username you assigned them and the default
password, password.

12. The user should change their password the first time they log in. See Changing Your Password
for more information.

£~ Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

ORACLE’ Insurance Insbridge RateManager Version: 04.05.00 Subscriber: alamere User: Company Administrator
File  Modues Tools  Help
Home @ User Management % =

‘ [z Add User
You have selected to add/edit an user that vil beleng to a 'Group that vill cantrol hisfher rights for all Insbridge applications and 2 ‘Gempany’ that offers high level grouping for security, All new users vill have 2 default password that shoukd be changed en a successful login
for security rezsons. The required information is noted with 2n asterisk.

Groups

Member Of: Select Groups: *
ADMIN Rateloaders
QA
<< Ratefinalysis
BA

‘Company alamere w|*

Firstname

Lastname

Username €

Department

Hetwark User

Phone

Email

Password Expires 9 O

2. Lancel

Figure 42 Adding a New User

Removing a User Group

To remove a user from a group, select the Group(s) the user will be removed from and click Select Arrow
— Move Right. Upon saving, the user will no longer belong to that group.
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EDITING A USER

This section allows an administrator to change a user's information such as their email address or phone

number. It also allows for a user’s password to be reset.

To Edit a User
1. Navigate to the User Management tab.

ORACLE" Insurance Insbridge RateManager

File Modules  Tools Help

Hrir

& User Management X

User Management

Mew Ff’ Edit & Delete E’ﬂ Refresh

MName Contact Info

Last Login

Company Administrataor

- - z
Mary Elliott ! melicttEerample. com
%2 (972) 555-0110

— AzronEeample.com
S (214 GEE-0109

Figure 43 User Management for Editing a User

Aardn Quader

Mar 7 2011 10:43AM

Mar 7 2011 8:34AM

Mar 7 2011 S:08AM

2. Select the user you want to edit and click EDIT. You also can edit a user by double-clicking their

name.

3. This will open the Edit User tab. This screen is similar to the Add User tab and all information can

be edited, with the following exception: the reset password option.

4. When you have finished making changes, click SAVE to update the user's information and
refresh the user listing. If you do not want to save your changes, click CANCEL.

Resetting User Passwords

You have the option to reset a user's password. If a user forgets their password, you can reset it on the

Edit User tab.

1. Navigate to the User Management tab

2. Select the user whose password you want to reset and click EDIT. This will open the Edit User

tab.

3. Scroll to the bottom of the tab and check the reset password box. The user's password will be

reset to the default password, password.
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‘ Home

File — Modules  Tools

Help

| @ user Management

/= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

ORACLE’ Insurance Insbridge RateManager

X

| @ Edit user

Groups

Company

Firstname

Lastname

Username @)

Department

Hetwork User

Phone

Email

Password Expires &)

Member Of:

You have ssiscted to add/edit an user that will belang to 3 ‘Group’ that wiill contral hisfher rights for all Insbridge appications and a ‘Company' that offers high level grouping for security. All nev: users viil have s default password that should be changed on a successful login
for security reasons. The required information is noted with an asterisk,

Select Groups:

Rateloaders

ADMIN

QA
Ratefnalysis
BA

alamere

=

Mary
Elliott
MEliott

Rateloading

972-555-0011

MaryE@example.com

O

Reset Password

O

o save @ Cancel

Figure 44 Resetting a Password

4. Click Save to save your entry.

The user should change their password the next time they log in but will not be required to do so.

DELETING A USER

If a user is no longer needed, they can be deleted. Any user at any time can be deleted. Only the Admin
user cannot be deleted.

To Delete a User

1. Navigate to the User Management tab.

2. Select the user you want to delete and click DELETE.
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ORACLE" Insurance Insbridge RateManager -

File Modules  Tools  Help

Home 1 User Management X
=)

User Management

E Mew @ Edil X Delete I'\_!a Fefresh u

;Name |Contact Info ;LESt Login
Company Administrator Mar 7 2011 10:43AM
Mary Elliott = meliott@example.com Mar 7 2011 8:544M
% (972) 555-0110
-‘JMMM Mar 7 2011 9:03AM

Aaron Quader
Q @ (214) 555-0109

Figure 45 User Management for Deleting a User

3. You will be asked to confirm deletion of the user.

2 Confirm Delete -- Webpage Dialog @

Are you sure you would like to delete the

[ ]
\1—/'1 selected user?

2 Ok ## cancel

Figure 46 Confirmation Message for Deleting a User

4. Click OK to delete the user and refresh the user listing. Click Cancel to return to the user listing
without deleting the user.
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GROUP MANAGEMENT

The group management tab allows an administrator to add, edit and delete user groups. RateManager
groups are used to assign rights to a set of users. You must create groups prior to creating users.

For example, you may have one group called Testers that can only access the Testing module and
another group called AutoLoaders that only has access to the auto line of business.

The Admin group is a default group and will be the only group in a new system. This group cannot be
deleted or edited or have their rights edited. All other groups must be created. The Admin group is the
only group that has access to the Security module of RateManager.

{= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

Fle Modues Tools Help

[ Home | @ Groupmanagemer x =M

I ‘ Group Management
[ mew | [ edit 3€ pelete | T Rights | §) Refresh

Group Description Location Users
ADMIN ADMIN 1

Selected Menu Ttem:  Group Manzgement

Figure 47 Group Management
From here, you can:

Add a Group

Edit a Group

Edit a Group's Rights
Delete a Group
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Navigating to Group Management

1. Select Tools=>Security>Group Management.

2. This will open the Group Management tab.

FUNCTIONALITY

The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on
this tab.

Functions:

New New: Opens up the Add Group tab where new groups can be added to the system and
auditing levels can be set. .

[# Edit | Edit: Opens up the Edit Group tab where group information can be updated.

9€ Delete Delete: Deletes the selected group. Before deleting a group, you must remove all
members from the group.

% Rights | Rights: Opens the Rights screen where you can manage group’s rights. .

lifi) refresh | Refresh: Refreshes the list of groups.

FIELDS

The main body of the tab displays the groups that have been created. There are four fields in the main
body of the Group Management tab. .

Name: The name of the group.
Description: A description of the group.
Location: The location entered for the group.

Users: The number of users in this group.

ADDING A GROUP

New groups can be added from the Add Group tab at any time. There are two steps to creating a group:

Step 1: Add the Group — This step creates the group and allows you to add information about
the group. The step is performed on the Add Group tab.

Step 2: Assigning Group Rights — This step defines the permissions this group will have. This
step is performed on the Group Management tab—>Rights screen.

On the Add Group tab, there are two icons and two buttons located on the tab.
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Required: A red asterisk indicates that this field is required. You will not be allowed to
save your entry unless all the required fields are complete.

@) | Information: Click the information icon to see more information about the entry.

Save: Saves your entry. The Save option is located in the lower right hand corner of
& swe || ipetan

@ c : | Cancel: Cancels any changes and returns you to the User Management tab. The
-anee Cancel option is located in the lower right hand corner of the tab.

To Add a Group

1. Navigate to the Group Management tab.

2. Click NEW to open the Add Group screen.

{= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer

ORACLE’ Insurance Insbridge RateManager

File Modules  Tools Help
[ Fome | @ Group Managemer  x ==
‘ [2 Add Group
You have selacted to sdd/edt 2 group. This group vill serve 2s 2 high level grouping for users. A particular user's rights are dtermined by the group(s) that they are associsted with. The description of the group wil help give clarification though # is not required, The required
information is noted with an asterisk.
Name
Description
Location
Email
Auit &)

& save &) cancel
——
Figure 48 Adding a Group

3. Enter a Name for the new group. The name can be any combination of alphanumeric characters,
with one to fifty characters. Blanks, periods, underscores, etc. are not allowed.

4. Optionally, enter a Description, Location and Email address for the new group.
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5. Check if you want Auditing for this group.
6. When you are finished, click SAVE. The group will be added and the group list will be updated.

Users can now be assigned to the group through User Management.

Auditing

Auditing is set at the group level and applies to all members of the group. If a user is assigned to more
than one group, auditing will apply to the group(s) that has it activated.

There are three levels of auditing:
1. None: Auditing will not be tracked for the group.
2. Normal: All saves and deletes for the group will be tracked.
3. High: All new items, saves and deletes for the group will be tracked.

If auditing is set to normal or high, a log will be kept for changes and actions done by each member of the
group. If auditing is set to none, no logs will be kept. Audit logs are displayed in the Audit module.

Auditing is also displayed in the View History report. The View History report will contain audit logs for the
users who have auditing in place. For example, if your RateLoading group has auditing set to high and
your BA group has no auditing, the View History report will only contain the actions done by the
RatelLoading group. Since the BA group did not have any auditing turned on, none of their changes or
actions will be listed in either the Audit Module or the View History report. The level of auditing will
determine the detail of the View History report.

No Permissions to Work in Lines

After a group has been added, you must assign group permissions. If you do not, users will not have
access to lines.

If a user does not have access to lines of business, they are not assigned to a group that has the proper
permissions. Have the user close out of their session prior to changing their group or group permissions.

ORACLE' Insurance Insbridge RateManager Version: 04.05.00 Subscriber: alamere User: Company Administrator

File  Modules Tools  Help

Home Program Explorer X = E

Program Explorer
New Frogram | 3 Manage Folders | T Create Package | (Bl Tnput XML ~
R —

e L ml
)nkfor Program: L) Search

&b Access Denied to l Lines

Folder Detail
B Name 1D Version Parent Folder Line Date Last Modified

No program data found

Figure 49 Users Denied Access to Lines
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Group Rights

Group Rights are broken into areas and lines of business. You can allow users access to the entire
system or just certain modules. You also can restrict users from performing certain actions, such as
packaging or creating folders.

PACKAGE

Permissions to Grant

RateManager Workflow
Programs — X
Write Access — X
Scenario — X
Write Access — X
Workflow Mapping — X
Write Access — X
Inputs — X
Write Access — X
Workflows — X
Write Access — X X
RateManager Package Admin
Program Export — Allows users to export programs. X X
Program Import — Allows users to import programs. Found in Tools=>Import. X X
Release Management — Allows users to access the Releases Module. X X
Database Support
Backups — Allows users to create database backups within RateManager. X X
Restores — Allows users to restore databases within RateManager. X X
LOB
Variables — X
Write Access — X
Algorithms — X
Write Access — X
Driver Assignment — AUTO LOB ONLY X
Write Access — X
Sequencing — X
Write Access — X
Output Mapping — X
Write Access — X
Inputs — X
Write Access — X
Categories — X
Write Access — X
Program Management — X
Write Access — X X
Lock Admin — X
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Permission to Grant Definitions

There are four areas:

1.

RateManager Workflow — Allows users to work in the Workflows Module.
a. Read permissions are granted to all areas in Workflows by checking any element.
b. Write permissions are granted per element. Checking a write permission will also grant
read permission to all areas in Workflows.
c. Package permissions are in the Workflows section. Checking a write permission will grant
package permissions as well as grant read permission to all areas in Workflows.

RateManager Package Admin — Allows users to work with packages in the system. Users are
granted full access when the element is checked.

Database Support — Allows users to work on Database Backups and Database Restores. Users
are granted full access when the element is checked.

LOB — Each line of business will have rights separate from the other lines.

a. Read permissions are granted to all areas within the line by checking any element.

b. Write permissions are granted per element. Checking a write permission will also grant
read permission to all areas in the line.

c. Package permissions are in the Program Management section. Checking a write
permission will grant package permissions as well as grant read permission to all areas in
the line. Package permissions also allows for users to manage folders, move, copy, and
create revisions.

User Actions Definitions

Write Access will allow users to create and edit entries. Users who do not have write access will have
Read-Only access unless access to the entire module has not been granted.

View — Allows users to view the elements that have been created.
Write — Allows users to create, edit, copy, and delete elements.
Package — Allows users to create RateManager, SoftRater and Global Versioning packages.

Lock — Allows users to lock programs.

Assigning Group Rights

Edit group's rights when you want to change the applications and lines of business users of that group
have access to.

1.

2.

Navigate to the Edit Group tab.

Select the group whose rights you want to edit and click RIGHTS. If an email address has been
entered for the group, the group's name will be underlined (such as Admin). For these groups,
click to the right of the name to select them.

This will open the Rights Management window.
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-3 [#] Programs

-3 [¥] Scenario

-3 [#] Wiorkflow Mapping
#-3 [¥] Inputs

&[] Workflows

=3 Rateianager Package Admin - Access Denied
-~ [] Program Export

-~ [] Program Impor

-3 [] Release Managemant

=& Datahase Support - Access Denied

-3 [ ] Backups

-3 ] Restores

=& RateManager Auto - Access Granted

-G [#] Variables

- [¥] Algatithms 7

2 Save | €) close |

Figure 50 Expanded Group Rights Management Screen

4. From here, you can assign rights to the group for the various modules of RateManager. Expand
the appropriate section and place a check next to an item to give the group access to that
section.

For example, if you wanted to allow this group to access and change sections of the Auto line of
business, you would expand RateManager Auto by clicking the [# (plus box). You would then
expand each section of Auto (Variables, Algorithms, etc.) and place a check in the Write Access
box for each section where you wanted users to have access. If you only wanted to allow a group
to view a section, but not make any changes, you would only place a check next to that item and
not the Write Access box.

5. When you are finished making changes, click SAVE. To cancel your changes, click CLOSE.

EDITING A GROUP

Edit a group when you want to change the group's name, description, location or email address. Any
changes will apply to all members of the group.
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To Edit a Group

1. Navigate to the Group Management tab.

2. Select the group you would like to edit and click EDIT. You also can edit a group by double-
clicking it. If an email address has been entered for the group, the group's name will be
underlined (such as Administrator). For these groups, click to the right of the group name to
select it or click the underlined name to send the group an email.

3. This will open the Edit Group tab.

File Modules Tools Help

Horme g Group Managemer X

[z Edit Group

You have selected to add/edit a group. This group will serve as a high level grouping for users. A particular user’s rights are determi
information is noted with an asterisk.

Mame Rateloading
Drescription

This group will load rates,

Location Plano
Email
Audit 9 High |

Figure 51 Editing a Group

4. Allfields can be edited. Make your changes.

5. When you have finished making changes, click SAVE to update the group's information and
refresh the group listing. If you do not want to save your changes, click CANCEL.
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DELETING A GROUP

If a group is no longer needed, it can be deleted. Only groups that currently have no users assigned to
them can be deleted.

To Delete a Group

1.
2.

Navigate to the Group Management tab.

Select the group you want to delete and click DELETE.

If the group currently has users assigned to it, you will receive an error.

IUnable ko delete group with users, Remaove the users from the group and by
YOUrF request again,

Figure 52 Error Message for Deleting a Group

Remove all users from the group by either deleting the users or assigning the users to another
group (see Editing a User) and then try your delete request again.

2 Confirm Delete -- Webpage Dialog @

™ Are you sure you would like to delete the

!_/1 selected group?

2? Ok | 3 cancel |

Figure 53 Deleting Group Confirmation Message

If the group does not have any users assigned to it, you will be asked to confirm deletion of the
group.

Click OK to delete the group and refresh the group listing. Click Cancel to return to the group
listing without deleting the group.
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Group Management Tab
A completed Group Management tab will list the groups, the location of the group and the total number of
members in each group.

The number of users may be greater than the total number of users. Users may be assigned to more than
one group.

EEX

/= Oracle Insurance Inshridge RateManager 04.05 - Windows Internet Explorer

File  Modules Tools  Help

[ Home | % Groupmanagemer x

I ‘ Group Management
i [ new [ edit| 3 Delete | % Rights | ) Refresh ¢

Group Description Location
ADMIN ADMIN

Users

Rateloading This group will load rates Plano 2
QA QA for the team Dallas 2
RateAnalysis. Rating analysis Frisco 2
BAJ Business analysis for rating New York 2

Selected Menu Ttem:  Group Managzment

Figure 54 Completed Group Management Tab

Viewing Group Contact Information

If you have entered any contact information for the group, you can view that information by hovering your
cursor over the group name.

B Ba group handles rate mappings.

BA@example. com
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SESSION MANAGEMENT

The Session Management tab allows an administrator to view users who currently have a RateManager
session open and disconnect them to free up a locked element.

/= Oracle Insurance Insbridge RateManager, 04.05 - Windows Internet Explorer

ORACLE |nsurance Insbridge RateManager

File  Modules  Tools  Help

Version: 04.05.00 Subscriber: alamere User: Company Administrator

i
)

|_ Home _\ gl Session Managem X

I ‘ Session Management
¢ < Deactivate License License Locks | (gl Refresh |

User Issue Date Comments
[] company Administrator ~ Mar 7 2011 10:16AM 10.143.222.120-10.143.8.155-
[] Company Administrator ~ Mar 7 2011 10:16AM 10.143.222.120-10.143.8.155-
[ Company Administrstor ~ Mar 4 2011 11:224M 10.143.223.120-10.143.8.155-

Selected Menu Ttem: Session Mansgement

Figure 55 Session Management

From this tab you can:

o Deactivate a License
o Display the users who have an Element or Program Lock

FUNCTIONALITY

The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on
this tab.
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Functions:

Deactivate License: Deactivates the license of the selected user. This will

2% Deacivale Licxse immediately end their session.

Edit: Unlocks a locked element by forcing an edit tab to close. Any changes made

4 Li Locks .
e on a forced close tab will not be saved.

iif) refresh | Refresh: Refreshes the list of open sessions.

FIELDS

The main body of the tab displays the sessions that are currently open. There are four fields in the main
body of the Session Management tab.

Checkbox: Check this box to perform an action on this session.
User: The name of the user who has a session open.
Issue Date: The time stamp that the session began.

Comments: The IP or URL of the open session.

To Navigate to Session Management

1. Select Tools—> Security>Session Management.

2. This will open the Session Management tab.

DEACTIVATING A SESSION

If a user quits RateManager without first logging out, their session may remain open. In this event, you
need to deactivate the session. Deactivating a session will also release any locked elements that this
user may have outstanding.

To Deactivate a Session

1. Navigate to the Session Management tab.

2. Place a checkmark next to each session you want to deactivate (free up) and then click
DEACTIVATE LICENSE.

3. You will be asked to confirm the deactivation.
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A Confirm -- Webpage Dialog

™ Are you sure you want to disconnect each

_!_/jl selected session?

2 Ok | ## cancel |

Figure 56 Confirming a Deactivation

4. Click OK to deactivate the session or Cancel to return to the Session Management tab.

UNLOCKING ELEMENT LOCKS

The system administrator can end the session of the user who is locking an element. This will free the
element up allowing other users to access the element. You can view information about who has an
element locked by hovering your cursor over the In-Use icon found on the Program Details tab.

The Locked Items by User box is for information only. No action can be performed here. If you need to
end this user’s session, you can deactivate the session. This will free the element up.

| ] Auto - 75202 [Version 3]
MNew - {E Sequencing @ Qutput Mapping ﬁ Create Package El Test Program _| MNotes E’ﬂ

Program Detail Folders .
Search: : [ Search Curre
n Globals N —
(4 Inputs Folder Detail
L3 Table Variables G LY Mame Revision | Element Ty
|1 Calculated Variables 5:; Count 1 Rating
Result Variabl . .
[ Resuit Variables %) Disc62010 1 Rating
3 Algorithms )
3 Driver Assignment Locked By: Company Administrator Hng
& Locals tni Eate;j :;I.I| .14 1?IE:I[II; 21 26PM ring
ock Duration: minute(s o
[ Table variables Herwritir
[ Calculated Variables PrvPassBI 1 Rating
[ Algorithms ViolExc 1 Underwritir
[_d Driver Assignment

Figure 57 User Session with Extended Locked Element

To view a locked session, place a check mark in the box next the user and click License Locks. A popup

window will be displayed indicating which element the user has locked and for how long.
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DATABASE
The Database Module can be found on the Tools menu. The Database module is where you manage
database functions from within RateManager. There are two options you can select:

e Backups — used for creating and restoring database backups.

o Updates — a listing of available updates for this version of RateManager.

BACKUPS

The backup tab located in the Database option of RateManager allows an administrator to create and
restore backups of the RateManager database. You must be a Disk Admin to perform backups or
restores.

/2 Oracle Insurance Inshridge RateManager 04.05 - Windows Internet Explorer ‘ZHEWX‘

File  Modules Tools  Help
| Home | [ DB Backups X =M
| GF DB Backups
: [ Create Backup | ) Restore Backup | 3§ Delete Backup(s) | §ff) Refiesh

Type Hame Location Date Size

Selected Menu Item: Datsbase Management

Figure 58 Database Backups
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FUNCTIONALITY

The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on
this tab.

Functions:

(5 Create Backup | Create Backup: Creates a backup of the currently selected database.

£} Restore Backup | Restore Backup: Restores the currently selected database.

3¢ Delete Backup(s) | Delete Backup: Deletes the currently selected database.

iif) refresh | Refresh: Refreshes the list of backups.

FIELDS

The main body of the tab displays a list of the current backups. There are six fields in the main body of
the DB Backups tab.

Checkbox: Check this box to perform an action on this backup.
Type: The type of backup performed, either Maintenance or Error.
Name: The name of the database being backed up.

Location: The location of the backup.

Date: The time stamp of the backup.

Size: The size of the backup.

Navigating to Database

1. Select Tools>Database>Backups.

2. This will open the Backups tab.

CREATING A BACKUP

If you need assistance implementing logic or an error is found in the system, a backup or snapshot can
be made of the database. That snapshot can then be sent to Oracle Insurance Support, where it will be
restored. Our support personnel and analysts can then work from the snapshot to determine the best way
to implement logic or diagnose a problem.
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To Create a Database Snapshot

1.

2.

N o o &

Navigate to the Backups tab.

Click CREATE BACKUP. This will open the RateManager Backup window.

RateManager Backup
DataBase: rm W
Backup Reason: | Maint b |

Backup Location: |C:".,]n5|:uridge‘.,DB_Ba::kup

Drescription: MonthhyMain,

2 Backup | €) Close |

Figure 59 Creating a Backup

Select the database you want to backup, either security or rm (RateManager). When creating a
backup to send to Oracle Insurance, select your rm database. The Name on the screen will
default to the actual name of the database in SQL Server.

Select a reason for the backup, either Maint (maintenance) or Error.
Enter a location where the backup should be stored. This location should be a network share.
Click BACKUP to start the backup process.

You will be informed when the backup operation is complete.

v’ Backing Up Database..... Start{6:36:15 P.M.) Stop(6:36:34 P.M.)

The database backup has successfully been created. To view a listing of backups
created, please browse to the location using your file explorer.

@ Close |

Figure 60 Successful Backup Message
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8. Your backup should be listed on the backups tab. If your backup is not listed, click REFRESH to
refresh the screen.

Sending to Oracle Insurance

If necessary, you may need to send it to Oracle Insurance Support for assistance.

1. Once the backup is complete, you can browse to the backup location you entered in Step 5. Sort
the listing by Date Modified to quickly find the backup you just created.

2. If necessary, Oracle Insurance Support will instruct you how to handle the database handoff.

RESTORING A BACKUP

1. If there’s a backup that needs to be restored, highlight the backup you want to restore and click
RESTORE BACKUP. A warning message will be displayed.

NOTE: If you require assistance or are unsure of whether or not to restore a backup, please log a
Service Request using My Oracle Support at https://support.oracle.com/.

RateManager Restore

Are you sure you want to replace the current database’s contents with the selected
backup on disk? (The current database's name will not change)

'IBRM_IB2" database from "6/ 28/ 2010 3:39:26 PIM"

q Resmlel €) Close |

Figure 61 Restore Warning Message

2. Click RESTORE to restore the backup or CLOSE to return to the previous screen.
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DELETING A BACKUP

If there’s a backup that you no longer need, you can delete it. Make sure this is the action you want to
take.

1. Highlight the backup(s) you want to remove. More than one backup can be deleted.
2. Click Delete Backup(s) from the top bar menu. A warning message will be displayed.

3. Click OK to remove the backup(s) or Cancel to return to the previous screen.

2 Confirm Delete -- Webpage Dialog @

Are you sure you would like to delete the
selected backup(s)?

2 Ok | #& cancel |

Figure 62 Deleting a Backup
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Permissions Error

If you do not have the proper permissions to run database backups or restores, you will receive an error
message.

Error executing script! The configured IBRLU database user must have
dbowwner rights to the IBRM, IBSR, and IE_CLIEMT database to execute the
scripts via the interface, Please conkact your database adminiskratar, Error
Details: Cannot Execute Slebb Command: Invalid column name 'DEPEN',

o Ok

Figure 63 Permissions Error Message

Database Backup Location Error

If you do not have a proper backup location set up, either on the server where your databases are located
or a network share, you will receive an error message.

a . K

¢’ Backing Up Database..... Start(12:37:28 P.M.)  Stop(12:37:28 P.M.)

Unable to backup database. If the database that you are backing up is not located on
the RateManager server, please contact your system admin for network share to use
for backup purposes, : Cannot Execute SQL Command: Cannot open backup device
"IBRM_Alamere_02072011_ 063506
{C:\Insbridge\DE_Backup\IBRM_Alamere_02072011_063506.dat)’. Operating
system error 2(The system cannot find the path specified.). BACKUP DATABASE is
terminating abnormally. Changed database context to "IBRM_Alamere’. If the problem
continues to occur, please contact your system admin for assistance.

@ Close |

Figure 64 Backup Location Error Message

In Figure 64, a backup location was entered (C:\Insbridge\DB_Backup...), but the location was not found.
Entering a location in the Preferences area of RateManager will not create the location. The loction must
be in place prior to the backup.

When a shared location on the server where the RateManager databases are located is entered, the
backup request can be performed.
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UPDATES

The database module also contains an update tab that lists the available updates for this version of
RateManager.

From this tab you can view the update script or execute the update. Updates cannot be deleted.

NOTE: Only a database owner can perform updates. If the Updates tab or any execute buttons are not
visible, you do not have access to the database.

/2 Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explorer,

ORACLE Insurance Insbridge RateManager

Version: 04.05.00 Subscriber: alamere User: Company Administrator
File  Tools  Help

| Home | DB Updates ® ==
‘ @ DB Updates

: [L Execute Update Senpt | L8 Open Update Scrpt | [l Save Update Scriptto File | B} Refresh

Sonipimto o]

Scnpt Release Date Database Status

v04.05.00.00 5/1/2011 IBRM

v04.01.00.00 11/15/2010 IERM

v04.00.0.00 3/10/2010 IERM

v03.13.0.00 12/15/2009 IERM Current

12.0.00 IBRM
IBRM
IBRM
IBRM
IERM

IBRM

Selected Menu Item:  Database Management

Figure 65 DB Updates

FUNCTIONALITY

The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on
this tab.
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Functions:

[L Execute Update Seript | Execute Update Script: Runs the selected update script.

Open Update Script: Opens the selected update script in a

R .
<3 Open Update Script window where it can be viewed or copied.

Save Update Script to File: Allows you to save the update script

Save Lipdate Seript to File to your local hard drive or network.

i) Refresh | Refresh: Refreshes the list of updates scripts.

Show Updates for: Allows you to select the update scripts you

Show updates for:| 18RM ¥!| want to view, IBRM or IB_CLIENT.

FIELDS

The main body of the tab displays a list of database updates. There are four fields in the main body of the
DB Updates tab.

Script: The name and version of the script.
Release Date: The date of the release for the script.
Database: The type of database the script is for, IB_CLIENT or IBRM.

Status: The status of the update. Current will be on the line of the most current database.

Navigating to Database

1. Select Tools>Database~>Updates.

2. This will open the Updates tab.

EXECUTING UPDATE SCRIPT

Database updates can be done on the IB_CLIENT database and the IBRM database. If you log into
RateManager and Tools is the only option, you must perform a database update.

On the Updates tab, the current version will be highlighted and the status will be Current. The updates
below the current version will be grayed out. These updates cannot be run again. You will receive an
error message if you attempt to run a lower version update. Any version update above the current version
will also be grayed out but will be available for executing after the preceding update has been run.

Updates have to be installed sequentially, meaning if you are on Version 3.12, you must run the 3.13
update, the 4.00 update, the 4.01 update and finally the 4.05 update. If you attempt to run an update that
is more than one level above the current version, you will receive an error message.
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NOTE: Itis strongly recommended that database updates be performed in RateManager.

1. Navigate to Tools->Database—>Updates.
2. The Updates tab will be displayed. Select the database you want to view from the Show

updates for drop down. The database updates for your selection will be listed. The last column,
the Status column, will show you which update is the Current one installed.

ORACLE" Insurance Insbridge RateManager

File  Tools Help

Home DB Updates ®

(3 DB Updates
J_-E Execute Update Script E Cpen Update Script E Save Update Script to File E’[ﬂ Refresh

Show updates for:| IBRM b
ﬁe Cate Database Status
vi4.05.00.00 5/1/2011 IBR.M
vi4.01.00.00 11/15/2010 IBRM
vil4.00.0.00 3/10/2010 IBRM
vi03.13.0.00 12/15/200%9 IBR.M
03.12.0.00 4/30/2003 IER.M
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Figure 66 Available Updates

3. There are two ways to execute an update:
a. Directly in RateManager
b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This will assure that the database showing as Current will have all possible updates.

4. Highlight the update you want to run.
5. Click EXECUTE UPDATE SCRIPT. A warning message will be displayed.

6. Click OK to run the update or Cancel to return to the previous screen.
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7. Do this for both the IBRM database and the IB_CLIENT database.

A Confirm Update -- Webpage Dialog, @

. Are you sure you want to replace the
;!_-/1 current database’s contents with the
. selected release script on disk?

e Ok | 8§ cancel |

Figure 67 Updating Scripts in RateManager

In SQL Server Using Query Analyzer

This method should be performed by a database administrator. You must have access to the SQL
Server instance where the RateManager databases are located. No warning message will be
displayed if you execute scripts in the wrong order. You must know the name of the databases you
are updating. If you are unsure, do not use this method.

WARNING: Running updates in a non-sequential order may result in severe database errors. No error
messages will be displayed if you run updates in an incorrect order.

1. In RateManager, highlight the update you want to run. If you are going from a much lower version
of RateManager, you may have to save multiple files for each database.

2. Click SAVE TO FILE. Your computers dialogue box will be displayed. Save the file to a location
of your choice. For IBRM scripts, it is recommended that you rename the file to
usp_IBRM_RO(version number).sqgl. For example the V4.05 update would be:
usp_IBRM_R040.05.sql. For IB_CLIENT scripts, it is recommended that you rename the file to
usp_IB_CLIENT_RO(version number).sql. For example the V4.05 update would be:
usp_IB_CLIENT_RO040.05.sql.

3. Open Query Analyzer in SQL Server.

4. Open up the DB script updates from the download file. You can open in any program you want,
such as Notepad.

5. Select the IB_CLIENT database. Create a new query.
6. Copy the DB script you opened to the query screen.

7. Execute the script. Any messages will be displayed in the lower portion of the screen. Fix any
errors before you continue.

8. Updates must be run in sequential order.

9. Do the same for the RM database.
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10. After the scripts have been run, return to RateManager. Click FILE->RELOAD. The status should
show current and the full RateManager menu should be displayed.

Open Update Script

To view the update script prior to execution, highlight the update you want to view. Click OPEN UPDATE
SCRIPT. The update script will be displayed in a separate screen.

23 IBRU : v04.05.00.00 -- Webpage Dialog

Qclose
P

-- Constraint
—— foriegn EKey
IF MOT EXISTS (SELECT * FROM sys.indexes WHERE object id = OBJECT_ID(N' [dbo].
[TYPFES DATA]') LND name = N'PE D5 TYPES Q')

print 'Missing [dbo].[PROGRAMS] Foreign Key [PE D5 TYPES Q] "'

GO
IF nmot EXISTS (SELECT * FROM sys.foreign keys WHERE object id = OBJECT ID(N'[dbo].
[FE_PROGRLMS SYSTEM COUNTRIES]') AND parent object id = OBJECT ID(N'[dbo].
[PROGRZMS] "))

print 'Missing [dbo].[PROGRAMS] Foreign EKey [FE PROGRAMS S5YSTEM COUNTRIES]'

GO

IF not EXISTS (SELECT * FROM sys.foreign keys WHERE object_id = CBJECT_ID(N'[dbo].
[FE_IMPORT PROGRAM VALUE IMPORT PROGRAM]') AND parent object id = OBJECT_ID(N®" [dbo].
[IMPORT PROGEAM VALUE] "))

print 'Missing [dbo].[IMPCRT PROGRAM VALUE] Foreign Key
[FE_IMPORT PROGRAM VALUE IMPORT PROGRAM®

GO
if NOT exists (gelect * from dbo.syscbjects where id = object _id(N'[dbo].
[FE_IMPORT TEMPLATE PFROGRAEMS]') and OBJECTPROFERTY (id, N'IsForeignKey') = 1)

print 'Missing [dbo].[IMPORT TEMPLATE] Foreign Key
[FE_IMPORT TEMPFLATE PROGRAMS]®

GO
if NOT exists (select * from dbo.sysobjects where id = cobject id(N'[dbo].
[FE_PROGRLM VERSIONS PROGRAMS]') and OBJECTPROPERTIY (id, N'IsForeignKey') = 1)

print 'Missing [dbo].[PROGRAM VERSIONS] Foreign Eey
[FE_PROGRLM VERSTIONS PROGRAMS] "

G0
IF NOT EXISTS (SELECT * FROM sys.foreign keys WHERE object id = OBJECT ID(N'[dbo].
[FE_LOOKUPVARS PROGRAMS]') AND parent cbject id = OBJECT ID(N'[dbo].[LOOXUP VARS]'))
print 'Missing [dbo].[LOOKUP VARS] Foreign Hey [FK LOOKUPVARS PROGRAMS]'
G0
IF NOT EXISTS (SELECT * FROM sys.foreign keys WHERE object id = OBJECT ID(N'[dbo].
[FK_INSTRUCTICNS GROUPS_PROGRAMS]') AND parent cbject id = OBJECT ID(N'[dba].

[INSTEUCTICHNS GROUPS]'))
print 'Missing [dbo] . [INSTRUCTICNS GRCOUFS] Foreign Key
[FE_INSTRUCTICNS GROUPS PROGRAMS] "

%
Figure 68 Script Viewer
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REQUIRED UPDATES

If you log into RateManager and Tools is the only option, you must perform a database update.

Please navigate to Tools—>Database—>Updates (Tab) and run the necessary updates. You will not be
able to continue until you run the updates.

= Oracle Insurance Insbridge RateManager, 04.05 - Windows Internet Explorer

Ll 0B update =

o Please run the update scripts on the database.

Figure 69 Please Run Update Scripts

/= Oracle Insurance Insbridge RateManager 04.05 - Windows Internet Explore

ORACLE Insurance Insbridge RateManager
File Tools Help

[ Datsbase » 5 EBackups

% IUpdates

Hom

Figure 70 Menu Requiring DB Updates

85



Chapter 8

CHANGING YOUR PASSWORD

You can change your password at any time. RateManager does not prompt users to change their
passwords.

It is recommended that you change your password periodically to prevent other users from logging in and
making changes using your user ID.

1. From the top bar menu, select Tools and then click Change Password.

ORACLE" Insurance Insbridge RateManager
File Maodules Tools Help

Home Change Password

5] Preferences

2. This will open the Change Password window.

Change Password

Cld Password YT
Mew Password YT

Confirm Password sessssesl

@ Update | 3 Close |

Figure 71 Change Password Screen

3. Enter your current password in the Old Password text box and enter your new password in the
New Password and Confirm Password text boxes.

Your password must be at least six, but fewer than twelve, alphanumeric characters.

4. When you are finished, click UPDATE to update your password. The next time you log into
RateManager, you will need to use your new password.

86



Chapter 9

PREFERENCES

Users with Administration rights will be able to access all options found on the Preferences screen. The
Preferences screen allows administrators to manage settings, and set Home Page options.

Non-administrators will only have the option to set their Home Page Snaps. Please see the RateManager
User Guide.

ADMIN SETTINGS

Administrators can edit web settings at any time from the Preferences screen. Changes will take place
after the user sessions have been ended.

From the Preferences screen, you can set pathways, define servers, backup shares, set preferences, set
batch threads, establish minimum ID lengths, display of override date-mask values for Importing Data for
Mapped Variables, allow users to edit data types within the application, and set the time for inactive
session timeout.

To Change Settings

1. Select Tools=>Preferences.

Tools Help

&'J Manage Lines
O Audit

|.|_5 Import Pragrams

' Migrate Wark Files

Security F

Change Passwiord

A Database 2
1]

Preferences

2. This will open the Preferences window. Select Web Settings. This option will be displayed if you
are an administrator.
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Preferences

= Settings

& Oracle Insurance Insbridge RateManager [Preferences] -- Webpage Dialog
User
t..Home Page

Web Settings
L Wel Settings

Messaging Server :

SoftRater Server :

Insbridge Configkml Pzth:  |C:\PROGRAM FILES\ORACLE\IGBU\INSERIDGE|\FRAMEWORK\Y
[locathost

Backup Share Folder

Location:

[lecalhost

Use Insbridge Com+
Adminz

| {Secure Channel) I:‘
Enforce Release Packaging:
Batch Package Threads:

| {Secure Channel) I:‘

Minimum Legin User ID
Length:

User must changs
password:

(Days)
Shaw Override Date Mask:

Allcvr Data Type Changs:

Inactive Session Time Out: {hrs}
Online Help Server:

Batch Results with Newiline:

My Recent List:

[lecathest
Default Proscy Script
Location:

Change Contral:

| http://vipad/wpad.dat
Mazimunn amount of

Figure 72 Preferences Settings

3. Make any necessary changes

w
g Save | @ Close |

immediately, you may have to end all user sessions.
Web Settings

4. When you are finished, click SAVE to update your settings. If you want to changes to take place
Insbridge ConfigXml Path

This is the path from IBFA. This pathway must match the IBFA path. You may need to change this path if
you have changed the path in IBFA. Please contact Insbridge support for further information.
It is strongly recommended that you leave the default.
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Messaging Server

RateManager is set up to run batches on the same server that RateManager is located on. If you have an
especially large batch to run and you want to batch to a different server, you will have to change server
locations here. Unless necessary, it is strongly recommended that you leave the default.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, you will use a local path. If the location is not local, you must be a disk admin to
change.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.

If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.
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Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and inputs and a fourth (date) for inputs and result variables only.

Setting this option to True will allow RateManager users change the data type of a variable or input.
Setting this option to False will not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting will place
a carriage return between result files. A False setting will result in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting is the default server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

My Recent List

My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the
user recently worked on. You can set the maximum number of elements to display in a snap. The default
is for the snap list to be limited to 10.
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Default Proxy Script Location

The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog
Feed snap. This setting can be used for RSS feeds.

Change Control

If change control is on, it will be mandatory for users to enter a change control entry and justification to
any element or program when it is revisioned. If change control is off, the option will not be presented.

Maximum Amount of Simultaneously Opened Tabs

Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you
will allow users to have opened in RateManager. The default is 15.
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VIEWING VERSIONS

The Version option in the Tools section of RateManager allows an administrator to view the version
information for the current system.

To View a Version

1. From the Home tab, select Help>RateManager Version.

ORACLE" Insurance Insbridge RateManager
File Maodules Tools Help |

n@ RateManager Help

Home

RateManager Yersion

2. This will open the Version Listing window.

About RateManager E

IBRU System. Yeb. Ul . WebControls.Label Copynght @2011, Oracle. All nghts reserved. -

Yersion Lishing

IERH w04 .05.00.04
IE_CLIEWT w04 .05.00.00
Fr.OLL 04.05.00 [36]
IEF& 04.05.00 [36]

Figure 73 Version Listing

3. The latest version information including RM schemas, IB Client schemas and build will be
displayed.
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CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System product,
please log a Service Request using My Oracle Support at https://support.oracle.com/.

Address any additional inquiries to:

Oracle Corporation
World Headquarters
500 Oracle Parkway
BeSdVXOOd Shores, CA 94065

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200
oracle.com

TTY ACCESS TO ORACLE SUPPORT SERVICES

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United
States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398.
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Appendix

COUNTRY CODES

NAME ABBR
AFGHANISTAN AFG
ALBANIA ALB
ALGERIA DZA
AMERICAN SAMOA ASM
ANDORRA AND
ANGOLA AGO
ANGUILLA AlA
ANTARCTICA ATA
ANTIGUA AND BARBUDA ATG
ARGENTINA ARG
ARMENIA ARM
ARUBA ABW
AUSTRALIA AUS
AUSTRIA AUT
AZERBAIJAN AZE
BAHAMAS BHS
BAHRAIN BHR
BANGLADESH BGD
BARBADOS BRB
BELARUS BLR
BELGIUM BEL
BELIZE BLZ
BENIN BEN
BERMUDA BMU
BHUTAN BTN
BOLIVIA BOL
BOSNIA AND HERZEGOWINA BIH
BOTSWANA BWA
BOUVET ISLAND BVT
BRAZIL BRA
BRITISH INDIAN OCEAN TERRITORY 10T
BRUNEI DARUSSALAM BRN
BULGARIA BGR
BURKINA FASO BFA
BURUNDI BDI
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NAME ABBR
CAMBODIA KHM
CAMEROON CMR
CANADA CAN
CAPE VERDE CPV
CAYMAN ISLANDS CYM
CENTRAL AFRICAN REPUBLIC CAF
CHAD TCD
CHILE CHL
CHINA CHN
CHRISTMAS ISLAND CXR
COCOS (KEELING) ISLANDS CCK
COLOMBIA CcoL
COMOROS com
CONGO COG
COOK ISLANDS COK
COSTARICA CRI
COTE D'IVOIRE Clv
CROATIA (local name: Hrvatska) HRV
CUBA CUB
CYPRUS CYP
CZECH REPUBLIC CZE
DENMARK DNK
DJIBOUTI DJI
DOMINICA DMA
DOMINICAN REPUBLIC DOM
EAST TIMOR TMP
ECUADOR ECU
EGYPT EGY
EL SALVADOR SLV
EQUATORIAL GUINEA GNQ
ERITREA ERI
ESTONIA EST
ETHIOPIA ETH
FALKLAND ISLANDS (MALVINAS) FLK
FAROE ISLANDS FRO
FlJI FJI
FINLAND FIN
FRANCE FRA
FRANCE, METROPOLITAN FXX
FRENCH GUIANA GUF
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NAME ABBR
FRENCH POLYNESIA PYF
FRENCH SOUTHERN TERRITORIES ATF
GABON GAB
GAMBIA GMB
GEORGIA GEO
GERMANY DEU
GHANA GHA
GIBRALTAR GIB
GREECE GRC
GREENLAND GRL
GRENADA GRD
GUADELOUPE GLP
GUAM GUM
GUATEMALA GTM
GUINEA GIN
GUINEA-BISSAU GNB
GUYANA GUY
HAITI HTI
HEARD AND MC DONALD ISLANDS HMD
HONDURAS HND
HONG KONG HKG
HUNGARY HUN
ICELAND ISL
INDIA IND
INDONESIA IDN
IRAN (ISLAMIC REPUBLIC OF) IRN
IRAQ IRQ
IRELAND IRL
ISRAEL ISR
ITALY ITA
JAMAICA JAM
JAPAN JPN
JORDAN JOR
KAZAKHSTAN KAZ
KENYA KEN
KIRIBATI KIR
KOREA, DEMOCRATIC PEOPLE'S REPUBLIC OF PRK
KOREA, REPUBLIC OF KOR
KUWAIT KWT
KYRGYZSTAN KGZ
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Appendix — Country Codes

NAME ABBR
LAO PEOPLE'S DEMOCRATIC REPUBLIC LAO
LATVIA LVA
LEBANON LBN
LESOTHO LSO
LIBERIA LBR
LIBYAN ARAB JAMAHIRIYA LBY
LIECHTENSTEIN LIE
LITHUANIA LTU
LUXEMBOURG LUX
MACAU MAC
MACEDONIA, THE FORMER YUGOSLAV REPUBLIC OF MKD
MADAGASCAR MDG
MALAWI MWI
MALAYSIA MYS
MALDIVES MDV
MALI MLI
MALTA MLT
MARSHALL ISLANDS MHL
MARTINIQUE MTQ
MAURITANIA MRT
MAURITIUS MUS
MAYOTTE MYT
MEXICO MEX
MICRONESIA, FEDERATED STATES OF FSM
MOLDOVA, REPUBLIC OF MDA
MONACO MCO
MONGOLIA MNG
MONTSERRAT MSR
MOROCCO MAR
MOZAMBIQUE MOZ
MYANMAR MMR
NAMIBIA NAM
NAURU NRU
NEPAL NPL
NETHERLANDS NLD
NETHERLANDS ANTILLES ANT
NEW CALEDONIA NCL
NEW ZEALAND NZL
NICARAGUA NIC
NIGER NER
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Appendix — Country Codes

NAME ABBR
NIGERIA NGA
NIUE NIU
NORFOLK ISLAND NFK
NORTHERN MARIANA ISLANDS MNP
NORWAY NOR
OMAN OMN
PAKISTAN PAK
PALAU PLW
PANAMA PAN
PAPUA NEW GUINEA PNG
PARAGUAY PRY
PERU PER
PHILIPPINES PHL
PITCAIRN PCN
POLAND POL
PORTUGAL PRT
PUERTO RICO PRI
QATAR QAT
REUNION REU
ROMANIA ROM
RUSSIAN FEDERATION RUS
RWANDA RWA
SAINT KITTS AND NEVIS KNA
SAINT LUCIA LCA
SAINT VINCENT AND THE GRENADINES VCT
SAMOA WSM
SAN MARINO SMR
SAO TOME AND PRINCIPE STP
SAUDI ARABIA SAU
SENEGAL SEN
SEYCHELLES sYC
SIERRA LEONE SLE
SINGAPORE SGP
SLOVAKIA (Slovak Republic) SVK
SLOVENIA SVN
SOLOMON ISLANDS SLB
SOMALIA SOM
SOUTH AFRICA ZAF
SOUTH GEORGIA AND THE SOUTH SANDWICH

ISLANDS SGS
SPAIN ESP
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Appendix — Country Codes

NAME ABBR
SRI LANKA LKA
ST. HELENA SHN
ST. PIERRE AND MIQUELON SPM
SUDAN SDN
SURINAME SUR
SVALBARD AND JAN MAYEN ISLANDS SIM
SWAZILAND SWz
SWEDEN SWE
SWITZERLAND CHE
SYRIAN ARAB REPUBLIC SYR
TAIWAN, PROVINCE OF CHINA TWN
TAJIKISTAN TIK
TANZANIA, UNITED REPUBLIC OF TZA
THAILAND THA
TOGO TGO
TOKELAU TKL
TONGA TON
TRINIDAD AND TOBAGO TTO
TUNISIA TUN
TURKEY TUR
TURKMENISTAN TKM
TURKS AND CAICOS ISLANDS TCA
TUVALU TUV
UGANDA UGA
UKRAINE UKR
UNITED ARAB EMIRATES ARE
UNITED KINGDOM GBR
UNITED STATES USA
UNITED STATES MINOR OUTLYING ISLANDS UMl
URUGUAY URY
UZBEKISTAN uUzB
VANUATU VUT
VATICAN CITY STATE (HOLY SEE) VAT
VENEZUELA VEN
VIET NAM VNM
VIRGIN ISLANDS (BRITISH) VGB
VIRGIN ISLANDS (U.S.) VIR
WALLIS AND FUTUNA ISLANDS WLF
WESTERN SAHARA ESH
YEMEN YEM
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NAME ABBR
YUGOSLAVIA YUG
ZAIRE ZAR
ZAMBIA ZMB
ZIMBABWE ZWE
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Glossary

GLOSSARY TERMS

A

Administrator:

The person designated by your company who has the authority to
create and change groups, usernames, passwords and restrictions.

Algorithm:

A sequence of steps used to perform a calculation.

Assigned Driver:

A driver who has been assigned to a vehicle.

Assigned Vehicle:

A vehicle that has been assigned a driver.

Authoring
Environment

The physical machine where RateManager is installed.

C

Calculated Variable:

Calculated Variables are used when a result cannot best be derived
from simple data mapping in a table. For example, if age is not passed
as an input, but is a criteria needed in determining other factors, you
would use a Calculated Variable to calculate driver age from the inputs
of effective date and driver date of birth. Calculated Variables look at
every node (driver, vehicle, location, etc.) independently and create a
result for each. Once a calculated variable is created, the result can be
used in any other variable.

Callouts A set of a single or multiple programs and/or SoftLibraries that allows
users to call needed operations at a specific time from either inside the
system or outside the system.

Category: A user defined group of information that defines inputs, variables,
algorithms and the overall structure of the program.

Criteria: An input or variable used in a mapped variable to determine which
value to return. Any input or variable can be used as a criteria.

D

Data Type: The type of data associated with a parameter. RateManager supports
three (decimal, integer and string) data types for variables and inputs
and a fourth (date) for inputs and result variables only.

Date: A data type supported for inputs and result variables only. For more
information, see Dates in the Contents section.

Decimal: A data type supported for all types of variables and inputs. Examples

of decimal values are 3.1415, 18 and 0.995.

Default Value:

Used by a mapped variable if no match is found based on the criteria.

Dependency:

When copying a variable, algorithm or driver assignment, any element
that requires another element to be present or defined will be listed. All
dependencies must be resolved.

Driver Assignment:

Driver assignment is an auto insurance specific method of assigning a
particular driver to a particular vehicle on a policy, based on certain
criteria. Criteria often differ on a carrier basis, and sometimes even on
a program level.

Driver Assignment

A driver assignment scenario is a list of instructions that define the
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Scenario:

main sequence of operations to properly define the driver assignment
logic for a carrier. A scenario is based upon the same algorithm
principle used throughout the RateManager software.

E

Export:

Exports allow users to export all elements of a program from one
database to another database or within the same database. Or to
export data in tab-delimited form, from a RateManager table to an
outside location.

=

Flag:

A variable that holds a 1 for true and a 0 for false.

Flag Driver Algorithm:

An algorithm used by a Flag Driver Function to flag drivers based on
certain criteria.

Flag Driver Function:

A built-in function used in the main driver assignment that defines the
scope of the flagging operation. Most require an association with a
predefined Flag Driver Algorithm.

Flag Vehicle
Algorithm:

An algorithm used by a Flag Vehicle Function to flag vehicles based on
certain criteria.

Flag Vehicle Function:

A built-in function used in the main driver assignment that defines the
scope of the flagging operation. Most require an association with a
predefined Flag Vehicle Algorithm.

G

Global:

An input or variable that is available to all programs under a specific
subline.

Global Input:

A value that is passed into the rating system.

Global Result:

A value that is passed out of the system after rating.

Group:

A set of users that have the same access rights.

IBFA

Insbridge Framework Administrator. IBFA is an administrative tool
used to configure Insbridge applications and setup RateManager
database connections. IBFA will be located on a Windows Server
machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

IBSS

Insbridge SoftRater Server. IBSS is the administrative tool for the
SoftRater engine. The SoftRater engine is a multi-platform component
within IBRU that executes the rules, rating and underwriting
instructions as defined by the user in RateManager. IBSS is usually
located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater
Server/SoftRater for Java.

IBRU

Insbridge Rating and Underwriting System. This is the entire system.

A step type available for use in calculated variables and algorithms.
For more information, see If in the contents section.

Import:

Import allows users to bring in programs from an outside location into
RateManager. Or to import data in tab-delimited form, into a
RateManager table.

Input:

A value that is passed into the rating system.

Integer:

A data type supported for all types of variables and inputs. Examples
of integer values are 3, 1859865 and -47.
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Interpolation:

An estimated value derived from two known values.

L

Library:

The Library is where templates are stored and managed.

Linked Variables:

Two or more mapped variables that have been associated with one
another because they use the same criteria.

Lock:

A lock will close all associated Variables, Algorithms, Driver
Assignments, Sequencing and Result Mappings in a program version
from deletions and edits.

Logical Environment

An environment created for a subscriber in IBFA. It defines package
location, engine location and database location in addition to several
other supporting data items. This environment is used for rating and/or
SRP management. Each database connection will have a logical
environment.

M

Mapped Variable:

A variable that uses other variables and inputs as criteria in
determining the appropriate value. See Mapped Variables in the
Contents section for more information.

Mask:

A feature that allows the customer to determine how data should be
interpreted. See Masking in the Contents section for more information.

N

Normal Rating

The most common type of algorithm. Examples of what it can be used

Algorithm: for are:
o Determine premiums
o Calculate differences in limits being passed into the system vs.
limits being rated by the system
o Assign tiers
@)
Operator: A built-in mathematical function used in calculations and comparisons.
P
Package: A small file that holds all the RateManager logic for a specific program

and version.

Package Location

A pointer to a location where SoftRater Packages (SRP's) are stored.

Physical Environment

A physical environment is generally referred to as a physical machine.

Program:

A planned group of procedures executed in a specific order to return a
rating. Programs in RateManager typically correspond to rate manuals.
Programs can be either created by the users or imported.

Program Date Mask:

Specifies how SoftRater interprets dates being passed into an input
file.

Program Folders:

A RateManager file management system that functions in much the
same way as Microsoft Windows Explorer. This multi level setup
allows for an unlimited number of program folders and subfolders to be
placed underneath a subline.

R

Rank Driver
Algorithm:

An algorithm used by a Rank Driver Function to rate drivers based on
certain criteria.
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Rank Driver Function:

A built-in function used in the main driver assignment that defines the
scope and sorting order of the ranking operation. Most require an
association with a predefined Rank Driver Algorithm.

Rank Vehicle An algorithm used by a Rank Vehicle Function to rate vehicles based
Algorithm: on certain criteria.

Rank Vehicle A built-in function used in the main driver assignment that defines the
Function: scope and sorting order of the ranking operation. Most require an

association with a predefined Rate Vehicle Algorithm.

Rating Environment

The physical machine(s) where SoftRater is installed. This is typically
the same as a SoftRater node.

Reconcile

A comparison feature that compares one program version against
another version in the same program and generate a report of the
differences.

Restrictions:

Limitations on viewing and editing pages and fields in the system.
Restrictions are assigned and changed by the Administrator.

Result Mapping:

A defined set of results, inputs and variables displayed in the output
file.

Revision: A variable specific type of versioning. See Versioning in the Contents
section for more information.

RM RateManager. RateManager is a component within IBRU that enables
users to manage the product definition and modification process,
including rating and underwriting logic.

S
Sequence: The order in which algorithms run. See Sequencing in the Contents

section for more information.

SoftLibrary:

A SoftLibrary is a specially developed program that performs a specific
task. SoftLibraries may run their own code or call upon other systems
to obtain information outside of RateManager, for example, obtaining a
credit score

SoftRater Node

A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

Source: The source is the creator of a template and will also be the name of
the new subline.

SR SoftRater. The engine that executes the rating, rules and underwriting
instructions defined within RateManager. The rating environment for
runtime execution and processing of business content. SoftRater can
be further defined by the operating system where it has been loaded.

SRP SoftRater Packages. A package that holds all the RateManager logic
for a specific program and version.

SR-JAVA SoftRater for Java. This is also another name for IBSS.

SR-WIN — SoftRater for Windows. This is also another name for IBFA.

String: A data type supported for all types of variables and inputs. Examples
of string values are "2.718", "The quick brown fox jumps over the lazy
dog." and "001".

Subline: Sublines are classifications that fall in between lines of business and

program folders. Sublines allow for the separation of programs by
source.
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T

Tab-delimited: A type of text file in which columns are separated by tabs. This is the
required format for importing tables into RateManager.

Template: Templates are exact copies of existing programs within a line of
business that can be from within your own user group, any other user
group within the company or even from an outside company.

U
Unassigned Driver: A driver who has not been assigned to a vehicle.
Unassigned Vehicle: A vehicle that has not been assigned a driver.
Underwriting A type of algorithm used to determine if a policy meets the
Algorithm: requirements of the company.
Universal: A collection of programs from all lines of business combined with result

group mappings and assigned to execute in sequence that returns a
single or multiple results.

Vv

Variable: A name used to represent a value that can change. See Variables in
the Contents section for more information.

Version: One of a sequence of copies of a program, each incorporating new
modifications. See Versioning in the Contents section for more
information.

VFS Virtual File Servers. Virtual file server management allows you to set
up servers that are in different locations where packages can be
downloaded.

w

Wildcard: An option available for mapped variables that tells RateManager that
one or more rows ignore the value passed in for the criteria. See
Variables in the Contents section for more information.

Workflow: A workflow is a type of program that allows you to call multiple
programs from different lines of business together under one universal
program.

Working Category: A classification used to define how elements should run. See
Categories in the Contents section for more information.

X
XML ID: A number automatically assigned by RateManager to identify inputs

and categories.
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Index
INDEX
A B
Accessing Backup
Line of Business, 15 Deleting, 78
Actions Restoring, 77
Import Wizard, 40 gtorlng, 7'3 6
Activated uccess Message, .
Line of Business Listing Screen, 17 Backup Share Folder Location
N Preferences, 89
Activating

Line of Business Listing Screen, 23
ActiveX Controller, 10

Adding
Group, 63
New Group in User Management, 62
New User in User Management, 56

Admin Rights, 87

Administrator
User Management, 54

Administrator Group, 61
Security Access, 61

Allow Data Type Change
Preferences, 90
Assigning
Group Rights, 67
Assigning Group Rights, 66

Audit
Menu Bar, 26

Audit Listing, 26, 55

Audit Logs, 25
Purging, 31
Viewing, 26
Audit Report, 30
Audits, 26
Creating, 30
Details, 31
Auditing
Group Management, 64
Groups, 64

Audits
Audit Report, 26
Change Control, 29
Deleting, 32
Fields, 26
Filter, 26
Filtering, 28
Purge All, 26, 32
Refresh, 26
Right Click Menu, 27

Authoring Environment Definition, 101

Batch Package Threads
Preferences, 89

Batch Results with New Line
Preferences, 90

C

Cancel
Group Management, 63
User Management, 56

Change Control
Audits, 29
Preferences, 91

Change Password, 86
Change Password Window, 86

Changing

Administrator Email, 89
Company

Selecting for New User, 56
Completion

Import Wizard, 44

Configure Program Import
Import Wizard, 38
Contact Information
Group Management, 70
Create Backup, 76
DB Backups, 75

Creating
Audit Report, 30
Backups of Database, 74
Database Snapshot, 75

Custom
Filter, 28

Custom Lines
Creating, 20

Custom Type
Line of Business Listing Screen, 17

D

Database
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Tools, 75

DataBase
Tools, 74

Database Error Messages, 79

Database Snapshot
Creating, 75

Database Tab, 74

Database Updates, 80
Running, 81
Tools, 83
Viewing, 81

Date Formats, 18

DB Backups
Create Backup, 75
Delete Backup, 75
Fields, 75
Menu Bar, 75
Refresh, 75
Restore Backup, 75

DB Updates
Execute Update Script, 81
Fields, 81
Menu Bar, 80
Open Update Script, 81
Refresh, 81
Save Update Script to File, 81
Show Updates for, 81

Deactivate License
Session Mangement, 72

Deactivating
License, 72
Line of Business Listing Screen, 23

Decimal Symbol, 19

Default
Groups, 61
Locale, 17
Sublines, 36

Default Proxy Script Location
Preferences, 91

Delete
Group Management, 62
Import Programs, 34
User Management, 55

Delete Audit, 27

Delete Backup, 78
DB Backups, 75

Deleting
Audits, 32
Database Backup, 78
Errors for a Group Delete, 69
Group, 69
Line of Business, 17
Programs From Tools, 45
User in User Management, 59

Description
Line of Business Listing Screen, 17

Details

Audit Report, 31
Digit Grouping Symbol, 19
Download to File, 47

Downloading
Files From Import Programs, 47

E

Edit
Group Management, 62
Line of Business Listing Screen, 16
User Management, 55

Edit Group Screen, 68

Edit User
User Management, 58

Editing
Group, 67
Line of Business Listing Screen, 22
User in User Management, 58
Web Config Settings, 87

Editing Group Rights
Example, 67

Edition Notice, 2

Email
Changing Administrator, 89

Enforce Release Packaging
Preferences, 89

Error Messages
Database Backup, 79

Errors
Creating Backups, 76
Deleting a Group, 69

Example
Editing Group Rights, 67
Execute Update Script, 82
DB Updates, 81

F

False
New Users, 57

Fields
Audits, 26
DB Backups, 75
DB Updates, 81
Group Management, 62
Import Programs, 34
Session Management, 72
User Management, 55

Filter
Audits, 26

Filtering
Audits, 28

Framework Administrator
Administrator Email, 89

Full Access, 10
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Group Rights, 67

G

Get Summary
Import on Tools, 39
Import Programs, 35

Global Imports
Importing in Tools, 44

Globals
Values in Sublines, 36

Group
Administrator, 61
Default, 61
Full Access Rights, 67
Name when Adding, 63
Removing User, 57
Rights Assigned to Users, 61
Security, 54
Selecting for New User, 56
Settings for Audit Logs, 64

Group Management
Adding a Group, 63
Auditing, 64
Cancel, 63
Delete, 62
Deleting a Group, 69
Edit, 62
Editing a Group, 67
Fields, 62
Group Rights, 65
Information, 63
Menu Bar, 62
New, 62
Overview, 61
Permissions, 64
Refresh, 62
Required, 63
Rights, 62
Save, 63

Group Rights, 65
Write Access, 66

Groups
Assigning Rights, 67

H
High

Auditing, 64
Home Tab, 13

IBFA Definition, 102
IBRU Definition, 102
IBSS Definition, 102

ID
Line of Business Listing Screen, 17

Import
Deleting Programs from Tools, 45
Import Programs, 34

Import programs
Saving Files, 47

Import Programs
Delete, 34
Fields, 34
Get Summary, 35
Import, 34
Menu Bar, 34
Refresh, 34
Right Click Menu, 35
Save To File, 34
Tools, 33
Upload From File, 34
Uploading Files, 45

Import Wizard, 36
Screen1t, 37
Screen11, 43
Screen12, 44
Screen?2, 38
Screen3, 39
Screen4, 40
Screen5-9, 41
Valid Actions, 40
Valid Statuses, 40

Importing
Import Wizard, 41
Rules for Global Imports, 44

Inactive Session Time Out
Preferences, 90

Information
Group Management, 63
User Management, 56

L

License
Deactivating, 72

License Locks
Session Mangement, 72

Line of Business
Accessing, 15
Activating Users, 21
Deleting, 17
Navigating To, 15
Navigation Bar, 16
Overview, 15
Setting Security, 21

Line of Business Listing Screen
Activated, 17
Activating, 23
Custom Type, 17
Deactivating, 23
Description, 17
Edit, 16
Editing, 22
ID, 17
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New, 16
Removing All Programs, 24
System Type, 17
Type, 17
Listing Screen
Line of Business, 17

LOB Listing Screen, 17
LOB Permissions, 64

Locale, 17
New Lines, 20
Selecting, 18
Updating, 18
Location
Work Files, 49

Logical Environment Definition, 103
Login, 9

Failure, 9

Help, 10
Logs

Audit, 25

M

Maint
Creating Backups, 76

Mandatory Database Updates, 85

Manual
Database Updates, 83

Maximum Amount of Simultaneously Opened Tabs
Preferences, 91

Menu Bar
Audit, 26
DB Backups, 75
DB Updates, 80
Group Management, 62
Import Programs, 34
Session Mangement, 71
User Management, 55

Menus
Tab, 11

Messages
Migrate Work Files, 53
Messaging Server
Preferences, 89
Migrate Work Files, 48
Manual, 50
Messages, 53
Tools, 49
Verfiy, 51, 52
Minimum Login User ID Length
Preferences, 90

My Recent Snap List
Preferences, 90

N

Name

Group Name Rules, 63
Navigating

Security RateManager, 54

To Line of Business, 15

User Management, 55
Navigation Bar

Lines of Business, 16
Network User

New User, 57

New
Group Management, 62
Line of Business Listing Screen, 16
User Management, 55

New Group in User Management
Adding, 62

New Lines
Creating, 20
Locale, 20

New User in User Management
Adding, 56

No Access, 10

None
Auditing, 64

Normal
Auditing, 64

Number Formats, 19

O

OBI Publisher, 31

Online Help
Preferences, 90
Online Help settings
Preferences, 90
Open Update Script, 84
DB Updates, 81
Overview
Group Management, 61
Line Of Business Screen, 15
Session Management, 71
Threading, 89
User Management, 54

P

Package Location Definition, 103

Password
Changing, 86
Default, 56
Reset, 58
Password Expires
New User, 57
Permissions, 10
Group Management, 64
Physical Environment Definition, 103

Preferences
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Allow Data Type Change, 90
Backup Share Folder Location, 89
Batch Package Threads, 89
Batch Results with New Line, 90
Change Control, 91

Default Proxy Script Location, 91
Enforce Release Packaging, 89
Inactive Session Time Out, 90

Maximum Amount of Simultaneously Opened Tabs,

91
Messaging Server, 89
Minimum Login User ID Length, 90
My Recent Snap List, 90
Online Help, 90
Online Help Settings, 90
Setting Options, 88
Show Override Date Mask, 90
SoftRater Server, 89
Use Insbridge Com + Admin, 89
User Must Change Password, 90

Processing

Import Wizard, 43
Purge All

Audits, 26, 32
Purging

Audit Logs, 31

R

RateManager
Security, 54

Rating Environment Definition, 104
Read Only, 10

Refresh
Audits, 26
DB Backups, 75
DB Updates, 81
Group Management, 62
Import Programs, 34
Session Mangement, 72
User Management, 55

Release 3.12
Work Files, 49

Release 3.13
Work Files, 49

Removing All Programs
Line of Business Listing Screen, 24

Required
Group Management, 63
User Management, 56

Reset Password, 58

Resolving Categories
Import Wizard, 40

Restore Backup, 77
DB Backups, 75

Restoring
Database Backup, 77

Right Click Menu

Import Programs, 35

Rights
Assigned by Groups, 61
Assigning to Groups, 67
Full Access, 67
Group Management, 62
Security, 54

Rights Management Window, 66

m
Backups to Oracle Insurance, 76
Creating Backups, 76

RM Definition, 104

Rules
Username, 56

Running
Database Updates, 81

S

Save
Group Management, 63
User Management, 56

Save To File
Import Programs, 34

Save Update Script to File
DB Updates, 81

Script
Executing Update, 82
Viewing Update, 84
Security
Access by Administrator Group, 61
Creating Backups, 76
Group Management, 61, 62
Navigating, 54
RateManager, 54

Select Arrow
User Management, 56

Selecting
Date Formats, 18
Locale, 18
Number Formats, 19

Server
Location of Work Files, 49
Manually Migrate Work Files, 50

Session Management
Fields, 72
Overview, 71
Unlocking Elements, 73

Session Management Tab, 72

Session Mangement
Deactivate License, 72
License Locks, 72
Menu Bar, 71
Refresh, 72

Setting
Security for Line of Business, 21

Setting Options
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Preferences, 88

Settings, 87
Editing Web Config, 87
Preferences, 87
Thread, 89

Show Override Date Mask
Preferences, 90

Show Updates for
DB Updates, 81

SoftRater Node Definition, 104

SoftRater Packages
Environments, 103

SoftRater Server
Preferences, 89

SR Definition, 104
SR-JAVA Definition, 104
SRP Definition, 104
SR-WIN Definition, 104

Statuses
Import Wizard, 40
Storing
Backup, 76
Sublines, 36
Subscriber, 9
Sync Menu
Creating New Line of Business, 21

System Type
Line of Business Listing Screen, 17

T

Tabs
Menus, 11

Template
Sublines, 36

Thread
Settings, 89

Threading
Overview, 89

Tools
Database, 75
DataBase, 74
Database Updates, 80, 83
Deleting Programs, 45
Import Programs, 33
Migrate Work Files, 49
Versions, 92

True
New Users, 57

Type
Line of Business Listing Screen, 17

U

Unlocking Elements

Session Management, 73

Update

Password, 86

Web Config Settings, 88
Updating

Locale, 18
Upload From File

Import Programs, 34
Uploading Files

Import Programs, 45

Uploading Program Export
Downloading Files, 47

Use Insbridge Com + Admin
Preferences, 89

User
Adding to Line of Business, 21
Audit Logs, 25
Deleting, 59
Editing, 58
Group Rights, 61
Network User for New, 57
Removing From Group, 57
Resetting Password, 58
Selecting Company for New, 56
Selecting Group for New, 56
Username for New, 56

User Authentication, 57

User Management
Cancel, 56
Delete, 55
Edit, 55
Fields, 55
Group Management, 61
Information, 56
Menu Bar, 55
Navigating, 55
New, 55
Overview, 54
Refresh, 55
Required, 56
Save, 56
Select Arrow, 56

User Must Change Password
Preferences, 90

Username
New User, 56
Rules, 56
Security, 54

Users
Password Expires, 57

V
Verify
Migrate Work Files, 51, 52

Verify Information
Import Wizard, 39

Version Information, 92
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Version Listing Window, 92 W
VFS Definition, 105 Web Confi
: . eb Config

View Audit Report, 27 Editing Settings, 87
View History Work Files

Auditing, 64 Location on Server, 49
Viewing Migrating, 48

Audit Logs, 26 Write Access

Database Updates, 81 .

Versions. 92 Group Rights, 66

Virtual File Server Definition, 105
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